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Abstract

These Application Notes describe the procedures necessary for configuring Bell Aliant Session
Initiation Protocol (SIP) Trunking Service with Avaya IP Office Release 9.0 and Avaya
Session Border Controller for Enterprise Release 6.2.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the PSTN with various Avaya endpoints.

Bell Aliant SIP Trunking Service provides PSTN access via a SIP Trunk between the
enterprise and Bell Aliant network as an alternative to legacy analog or ISDN-PRI trunks. This
approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Bell Aliant is a member of the Avaya DevConnect Service Provider Program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures necessary for configuring Session Initiation
Protocol (SIP) Trunking Service in between the service provider Bell Aliant and an Avaya IP Office
solution.

In the sample configuration, the Avaya IP Office solution consists of Avaya IP Office (hereafter
referred to as IP Office) 500v2 Release 9.0, Avaya Session Border Controller for Enterprise
(hereafter referred to as Avaya SBCE) Release 6.2, Avaya IP Office Video Softphone, Avaya Flare®
Experience for Windows and Avaya Deskphones, including SIP, H.323, digital, and analog. The
Avaya SBCE provides security for the Avaya IP Office solution, as well as interoperability features for
the SIP trunk.

During the interoperability testing, feature test cases were executed to ensure interoperability
between Bell Aliant and IP Office.

During the interoperability testing, a VPN connection was used to connect the simulated Avaya
enterprise network to Bell Aliant’s network via the public Internet. The connection could also be
done without the use of VPN, by directly connecting the Avaya SBCE to a public facing SBC
located in Bell Aliant’s network. This is accomplished by assigning public IP addresses, capable of
being reached across the public Internet, to the Avaya SBCE (interface B1) and to the Bell Aliant
SBC.

The Bell Aliant SIP Trunking Service referenced within these Application Notes is designed for
business customers. Customers using this service with the Avaya IP Office solution are able to place
and receive PSTN calls via a broadband WAN connection using the SIP protocol. This converged
network solution is an alternative to traditional PSTN trunks such as analog and/or ISDN-PRI
trunks. This approach generally results in lower cost for the enterprise.

The terms ““service provider” and “Bell Aliant” will be used interchangeable throughout these
Application Notes.

2. General Test Approach and Test Results

The general test approach was to simulate an enterprise site in the Solution & Interoperability Test
Lab by connecting IP Office and the Avaya SBCE to Bell Aliant SIP Trunk service via the public
Internet, as depicted in Figure 1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.
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Testing was performed with IP Office 500v2 R9.0, but it also applies to IP Office Server Edition
R9.0. Note that IP Office Server Edition requires an Expansion IP Office 500v2 R9.0 to support
analog, digital endpoints or trunks.

2.1 Interoperability Compliance Testing

To verify Bell Aliant SIP Trunking interoperability, the following features and functionalities were
exercised during the compliance testing:

SIP Trunk Registration (Dynamic) Authentication.

Response to SIP OPTIONS queries.

Incoming PSTN calls to various Avaya endpoints, including SIP, H.323, digital and analog at
the enterprise. All incoming calls from the PSTN were routed to the enterprise across the SIP
Trunk from the service provider networks.

Outgoing PSTN calls from Avaya endpoints including SIP, H.323, digital and analog
telephone at the enterprise. All outgoing calls to the PSTN were routed from the enterprise
across the SIP trunk to the service provider networks.

Incoming and outgoing PSTN calls to/from Avaya IP Office Video Softphone.

Incoming and outgoing PSTN calls to/from Avaya Flare® Experience for Windows.
Dialing plans including long distance, international, outbound toll-free, etc.

Caller ID presentation and Caller ID restriction.

Proper disconnect when the caller abandons the call before the call is answered.

Proper disconnect via normal call termination by the caller or the called parties.

Proper disconnect by the network for calls that are not answered (with voicemail off).
Proper response to busy endpoints.

Proper response/error treatment when dialing invalid PSTN numbers.

Proper Codec negotiation and two way speech-path. (Testing was performed with codecs:
G.711MU, G.711A and G.729A, Bell Aliant’s preferred codec order).

No matching codecs.

G.711 Fax Pass-through.

Proper early media transmissions.

Voicemail and DTMF tone support using RFC 2833 (leaving and retrieving voice mail
messages, etc.).

Outbound Toll-Free calls, interacting with IVR (Interactive Voice Response systems).
Calling number blocking (Privacy).

Call Hold/Resume (long and short duration).

Call Forward (unconditional, busy, no answer).

Blind Call Transfers.

Consultative Call Transfers.

Station Conference.

Mobility twinning of incoming calls to mobile phones.

Items not supported or not tested included the following:

Inbound toll-free calls and 911 emergency calls are supported but were not tested as part of
the compliance test.

T.38 fax is not supported by Bell Aliant; therefore T.38 fax was not tested, G.711 Fax Pass-
through was tested successfully and it’s recommended instead.
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2.2 Test Results

Interoperability testing with Bell Aliant was successfully completed with the exception of
observations/limitations described below:

Enterprise phones displays “anonymous”: On outbound calls, the 200 OK message sent by
Bell Aliant as a response to the INVITE sent by the enterprise included a P- Asserted-
Identity (PAI) header with a “sip:anonymous” parameter. The inclusion of this header made
the display on the enterprise extensions (calling party) change from the called number to
“anonymous@avay unavaila”, once the calls was answered by the PSTN party. To avoid this
issue, a Signaling Rule was created on the Avaya SBCE to remove the PAI header in the 200
OK messages sent by Bell Aliant on outbound calls.

No matching codec on outbound calls: If an unsupported audio codec is received by Bell
Aliant on the SIP Trunk (e.g., 722), Bell Aliant will respond with “487 Request Terminated”
instead of “488 Not Acceptable Here”, the user will hear re-order. This issue does not have
any user impact, it is listed here simply as an observation.

Outbound Calling Party Number (CPN) Blocking: To support outbound privacy calls
(calling party number blocking), IP Office sends “anonymous” as the calling number in the
SIP “From” header and includes “Privacy: id” in the INVITE message. During testing, Bell
Aliant’s network was configured to ignore the SIP “From” header for this purpose, thus the
Calling Party Number (CPN) was not blocked.

Blind Call Transfer using SIP phones do not complete until after the transferee answers
the call: When Blind Transfers are executed from 1100 Series SIP phones the transfer does
not complete until after the end user (transferee) answers the call. Scenario: A PSTN user
calls an enterprise SIP extension (1100 Series SIP phone), the call is answered. The
enterprise user then proceeds to do a blind transfer to another endpoint. Result: The expected
behavior on the enterprise SIP phone is to display “transfer completed” after answering “No0”
to the question “Consultative transfer with party?” which implies a blind transfer. Instead, the
SIP phone continues to display “transferring” until the transferee answers the call. The work
around is to hang up the SIP phone. There is no user impact, the transfer completes
successfully. This issue is only seen with the 1100 Series SIP phones.

Blind Transfers to the PSTN with REFER Support enabled: Blind Transfers to the PSTN
with “REFER Support” enabled in IP Office did not work properly. Scenario: With “REFER
Support” enabled in IP Office under the SIP Line tab, a PSTN user calls an enterprise
extension, the call is answered. The enterprise user then proceeds to do a blind transfer to
another PSTN endpoint. Result: The expected behavior is for the call to be released at the
enterprise extension doing the Blind Transfer (transferor) and for the SIP Trunk channel
resources in between the Service Provider and the enterprise to be released, leaving the two
PSTN endpoints connected and in the talking state. The actual result is that an announcement
is played to the enterprise extension user doing the Blind Transfer (transferor) informing the
user that the call did not complete. Consultative Transfer to the PSTN with “REFER
Support” enabled worked properly. Blind and Consultative Transfers to the PSTN with
“REFER Support” disabled also worked properly. Based on these results, Avaya
recommends to disable “REFER Support” if Blind Transfer is a required feature for the
enterprise. If Blind Transfer is not a required feature for the enterprise, and Consultative
Transfer can be used instead, Avaya recommends enabling “REFER Support”.

Call Display on Transferred Calls to PSTN: Caller ID display is not updated on PSTN
phones involved with call transfers from IP Office to the PSTN. After the call transfer is
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completed, the PSTN phone does not display the actual connected party but instead shows
the number of the host extension that initiated the call transfer (transferor). The PSTN phone
display is ultimately controlled by the PSTN provider, thus this behavior is not necessarily
indicative of a limitation of the combined Avaya/Bell Aliant solution. It is listed here simply
as an observation.

e Codec Lockdown on Outbound Calls: On outbound calls, Bell Aliant responds to the
INVITE request sent by IP Office, with multiple codecs instead of selecting one from the
INVITE SDRP list. IP Office uses the first compatible codec in the list. This behavior has no
user impact, calls were successful.

2.3 Support

For support on Bell Aliant systems visit the corporate Web page at:
http://www.bellaliant.ca/index.shtml

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.

3. Reference Configuration
Figure 1 below illustrates the test configuration used. The test configuration simulates an enterprise

site with an Avaya SIP-enabled enterprise solution connected to the Bell Aliant SIP trunk service
through the public Internet.

For confidentiality and privacy purposes, actual public IP addresses used during the compliance
testing have been replaced with fictitious IP addresses throughout the Application Notes.

The Avaya components used to create the simulated enterprise customer site includes:
Avaya IP Office 500v2.

Avaya Session Border Controller for Enterprise.
Avaya Voicemail Pro for IP Office.

Avaya 96x0 Series H.323 IP Deskphones.
Avaya 96x1 Series H.323 IP Deskphones.
Avaya 1100 Series SIP IP Deskphones.

Avaya IP Office Video Softphone.

Avaya Flare® Experience for Windows.

Avaya 1408 Digital Telephones.

Avaya 9508 Digital Telephones.
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Located at the edge of the enterprise is a VPN Firewall, followed by the Avaya SBCE. The Avaya
SBCE has two physical interfaces, interface B1 was used to connect to the public network via an
IPSec VPN Tunnel, interface A1 was used to connect to the enterprise private network. All SIP and
RTP traffic entering or leaving the enterprise flows through the Avaya SBCE and through the VPN
Firewall. The Avaya SBCE provides network address translation at both the IP and SIP layers.

Also located at the enterprise site is Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP codec’s.
IP Office LAN1 port connects to the inside (Al) interface of the Avaya SBCE across the enterprise
LAN (private) network. The outside interface of the Avaya SBCE (B1) connects to Bell Aliant’s
network via the public Internet as mentioned above.

The transport protocol between the Avaya SBCE and Bell Aliant, through the IPSec VPN Tunnel,
and across the public Internet, is SIP over UDP. The transport protocol between the Avaya SBCE
and IP Office, across the enterprise private IP network, is also SIP over UDP.

For inbound calls, the calls flowed from Bell Aliant to the Avaya SBCE through the IPSec VPN
Tunnel, then to IP Office.

Outbound calls to the PSTN were first processed by IP Office. Once IP Office selected the proper
SIP trunk; the call was routed to the Avaya SBCE for egress to Bell Aliant’s network through the
IPSec VPN Tunnel. Both, signaling and media packets, traversed through the IPSec VPN tunnel.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls across
the SIP trunk to Bell Aliant (refer to Section 5.11). The short code 9 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to the network. Since Bell Aliant is a Canadian
company, and Canada is a country member of the North American Numbering Plan (NANP), the
users dialed 7 or 10 digits for local calls, and 11 (1 + 10) digits for other calls between the NANP.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the enterprise. A complete discussion of the
configuration of these devices is beyond the scope of these Application Notes. However, it should be
noted that SIP and RTP traffic between the service provider and the enterprise must be allowed to
pass through these devices

For security reasons, any actual public IP addresses, user names and passwords used in the reference
configuration have been masked.
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Service Provider

Bell Aliant SIP trunk Registration

Username: User123

Realm: Realm Core SBC "d. I I
Password: Password123

Domain: pbx06dch2046.ca 1421257211 ‘

IP to register to: 142.125.72.11

162 168.1.137

2 VPN Firewall

\_ 10.10.170.162
Internet
' . . )
Simulated Enterprise
~ Avaya Domain: avaya.lab.com
5”“'T Border Controller DIDs: 506-694-8000 to 8009
or Enterprise
[ IPSec VPN Tunnel
172.16.5.71|A1 B11172.16.5.180 ":——___ —aat VPN Firewall
Desktop PC
Avaya 96x1 Series
IP Deskphones
- IP Office Manager (H.323)
- Voice Mail Pro Avaya 36x0 Series
- Avaya IP Office Video IP Deskphones A;:ﬂ:: :g 0
Softphone (SIP) {H.323) Deskiphones
Analog = Avaya Flare'® Experience (SIP)
9 Deskphones Dﬂgﬁ;ﬂ:ﬁ;:ﬁgs for Windows (SIP)
A
Figure 1: Avaya Interoperability Test Lab Configuration.
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4. Equipment and Software Validated

The following equipment and software/firmware were

used for the compliance testing.

Equipment/Software

| Release/Version

Avaya

Avaya IP Office 500v2

9.0.3.0 Build 941

Avaya IP Office DIG DCPx16 V2

9.0.3.0 Build 941

Avaya IP Office Manager

9.0.3.0 Build 941

Avaya Voicemail Pro Client

9.0.3.0 Build 212

Avaya Session Border Controller for Enterprise
(running on Portwell CAD-0208 platform)

6.2.1.016

Avaya 96x0 IP Deskphones (H.323)

Avaya one-X® Deskphone Edition
S3.220A

Avaya 96x1 Series IP Deskphones (H.323)

Avaya one-X® Deskphone H.323
Version 6.4014

Avaya 1120E IP Deskphones (SIP)

SIP1120e Ver. 04.04.14.00

Avaya IP Office Video Softphone 3.2.3.49 68975
Avaya Flare® Experience for Windows 1.1.4.23
Avaya Digital Deskphones 1408 38.0
Avaya Digital Deskphones 9508 0.55
Lucent Analog Phone --

Bell Aliant
Genband A2 17.0.12.16

ACME Session Border Controller (4500)

6.3.7 MR-1 Patch 3

HG; Reviewed:
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5. Configure IP Office

This section describes the IP Office configuration required to interwork with Bell Aliant. IP Office is
configured through Avaya IP Office Manager (IP Office Manager) which is a PC application. On the
PC, select Start = Programs = IP Office = Manager to launch IP Office Manager. Navigate to
File > Open Configuration, select the proper IP Office from the pop-up window, and log in with
the appropriate credentials. A management window will appear as shown in the next sections. The
appearance of IP Office Manager can be customized using the View menu (not shown). In the
screenshots presented in this section, the View menu was configured to show the Navigation Pane
on the left side and the Details Pane on the right side. These panes will be referenced throughout
these Application Notes.

These Application Notes assume the basic installation and configuration of IP Office have already
been completed and are not discussed here. For further information on IP Office, please consult
References in Section 10.

5.1 Licensing

The configuration and features described in these Application Notes require the IP Office system to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact
an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in the
Navigation pane and SIP Trunk Channels in the Group pane. Confirm that there is a valid license
with sufficient “Instances” (trunk channels) in the Details pane. Note that the full License Keys in
the screen below is not shown for security purposes.

IP Offices | i
=- & BOOTP (5) License |Remate Server
&g+ Operator 3)
=% 00EQQT06530F License Mode  License Normal
% System (L)
e PLDS Host1D 111309813681
<= Control Unit (4)
54 Extension (37) Feature License Key Instances Status Expiry Date Source Add...
- User G2) Small Office Edition WiFi AWWBISVOr... 255 Obsolete Never ADI Nodal
=-4§ Group (1) IPSec Tunnelling MIKenXtjMKysS... 255 Valid Never ADI Nodal Kemove
8% Short Code (65) Proactive Reporting #Dp8nbsaN@b... 255 Valid Never ADI Nodal
. g ;;’5“(‘1*) @ Report Viewer TuctTImdgdGt.. 255 Valid Never ADI Nodal
i elncommg Call Route 2) Mobility Features OICIURgHVKO:... 255 Obsolete MNever ADI Nodal
) WAN Port (0) Advanced Small Community Netw... DaQJI7VeSvUUF... 255 Obsolete Never ADI Nodal
@ Directory (0) IP500 Voice Networking Channels  T39BkqBXvd6al.. 255 Valid Never ADI Nodal
i) Time Profile (0) 1P500 Upgrade Standard to Profess.. QaHgn76v3j6C... 255 Obsolete Never ADI Nodal
. %;)";Wa't‘ P(ij"ﬁ(n 1P500 Voice Networking Channels  JaHLHAVEXDX.. 4 Valid Never ADI Nodal
oute -
am Account Code (0) SIP Trunk Channels | BCQzGBYDUsci... | 255 | Valid | Never | ADINodal
% License (74) VPN IP Extensions @qm3f0oR55_.. 255 Obsolete Never ADINodal
W& Tunnel (0) 1P500 Universal PRI (Additional cha... 2TXC@OoNQXt... 255 Valid MNever ADI Nodal
#-f5 UserRights (8] RAS LRQ Support (Rapid Response)  hXIRKBVCEKNV... 255 Valid Never ADI Nodal
* '5AR5(13 . IP Office Dealer Support - Standar.. 4AOGBVSDADa.. 255 Valid Never ADI Nodal
RAS Location Request (0) IP Office Dealer Support - Professi... dlyY DbaSUq7s.. 255 Valid Never ADI Nodal
1 Location (0}
IP Office Distributor Support - Stan... dvd56BOIXS_NK.. 255 Valid Never ADI Nodal
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5.2 LAN1 Settings

In the sample configuration, the MAC address 00E00706530F was used as the system name and the
LAN port connects to the inside interface of the Avaya SBCE across the enterprise LAN (private)
network. The outside interface of the Avaya SBCE connects to Bell Aliant networks via the public
internet. The LANZ1 settings correspond to the LAN port in IP Office. To access the LANL1 settings,
navigate to System (1) = 00E00706530F in the Navigation Pane then in the Details Pane navigate
to the LAN1-> LAN Settings tab. The LANL1 settings for the compliance testing were configured
with following parameters.

e Set the IP Address field to the LAN IP address, e.g. 172.16.5.60.

e Set the IP Mask field to the subnet mask of the public network, e.g. 255.255.255.0.

e All other parameters should be set according to customer requirements.

e Click OK to commit (not shown).

IP Offices |E 00E00706530F = E
3 & goOTP (5) system [ LANL | Lan2 [ ONs | voicemail | Telephony | Directory Services | System Events | sMTP [ SMDR [ Twinning [ vem [ ccr [ codees [ accs |
¢ Operator (3]
=1 00EQQT06530F LAN Settings |volP | Network Topology |
5 System
TP Address 172 . 16 5 60
&1 Line G)
5o Contral Unit (8) 1P Mask 255 . 255 . 255 . 0
: l‘, S;t:rné;; 6n Primary Trans. IP Address 0 0 0 0
=4 Group (1) RIP Mode None -
) 8% Short Code (65)
B service (0) Enable NAT
T RAS (1)
= Incoming Call Route (2) Number Of DHCP IP Addresses 200
€9 WAN Port (0) DHCP Mode
= Directory (0)
£7) Time Profile () Server Client Dialin @ Disabled Advanced
)@ Firewall Profile (1)
=l P Route 4)
Ba Account Code (0)
. License (74)
W& Tunnel (0)
=-§4 User Rights (8)
T ARS (1)
= RAS Location Request (0)
B Location (0)
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The VolIP tab as shown in the screenshot below was configured with following settings.

e Check the H323 Gatekeeper Enable to allow Avaya IP Telephones/Softphone using the
H.323 protocol to register.

e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to Bell

Aliant.

e Check the SIP Registrar Enable to allow Avaya IP Telephones/Softphone to register using
the SIP protocol.

e Enter the Domain Name of the enterprise under Domain Name.

e Verify the UDP Port and TCP Port numbers under Layer 4 Protocol are set to 5060.

e Verify the RTP Port Number Range settings for a specific range for the RTP traffic. The
Port Range (Minimum) and Port Range (Maximum) values were kept as default.

¢ Inthe Keepalives section at the bottom of the page, set the Scope field to RTP, Periodic
Timeout to 30, and Initial keepalives to Enabled. This will cause the IP Office to send RTP
keepalive packets at the beginning of the calls and every 30 seconds thereafter if no other
RTP traffic is present.

e All other parameters should be set according to customer requirements.

e Click OK to commit.

IP Offices 7 00E00706530F" [} o | < | >
- & EOOTE(S(Ja) | System [ LANL [1AN2 [ DNS | Voicemail | Telephony | Directory Services | System Events | sMTP [ SMDR | Twinning | veM [ cCR | Codecs [ Accs |
4% Operator
= 0E00T06530F [ LaN Settings | VelP | Network Topology|
H323 Gatekeeper Enable =
et Auto-create Extn [7] Auto-create User [] H323 Remote Extn Enable
<= Centrol Unit (4)
- Extension (37)
w-§ User(32)
-5 Group (1) SIP Trunks Enable
X Short Code (65)
4B Service (0) SIP Registrar Enable
ol RAS (1) [[] Auto-create Extn/User [] SIP Remote Extn Enable
- Incoming Call Route (2)
42 WAN Port (0) |D.,mam Name avaya.lab.com
= Directory (0)
141 Time Profile (0) upp UDP Port 5060 Remote UDP Port (5060
Firewall Profile (1)
IP Route (4) Layer 4 Protocol TP TCP Port |5060 Remote TCP Port |5050
h Account Code (0) —
-8 License (74) O Ts TLS Port 5061 Remote TLS Port 5061
g Tunnel (0)
-§i5 User Rights (8) Challenge Expiry Time (secs) 10
B¢ ARS (1)
i RAS Location Request (0) =
i Location (0)
Port Number Range
Minimum 49152 = Maximum 53246
Port Number Range (NAT)
Minimum 4a152 = Maximum 53246
Enable RTCP Monitering en Port 5005
Keepalives
Scope RTP » | Periodic timeout 30
Initial keepalives Enabled -
DiffSery Settings
B8 [2] DSCP(Hed B8 [2] VideoDSCP(Heq [FC |5 DSCP Mask (Heq 8% |2 SIGDSCP (Hex
46 [2] psce 46 [2] videoDsCP 63 [Z] DSCP Mask 34 [& siGDscP -
oK J“ Cancel | [ Help |
Ready Y
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In the Network Topology tab, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. In the compliance testing, it was set to Open Internet. With this
configuration, even the default STUN settings are populated but they will not be used.

e Set the Binding Refresh Time (seconds) to a desired value, the value of 300 (or every 5
minutes) was used during the compliance testing. This value is used to determine the
frequency that IP Office will send OPTIONS heartbeat to the service provider.

e Verify the Public IP Address is set to 0.0.0.0.

e Set the Public Port to 5060 for UDP.

e All other parameters should be set according to customer requirements.

e Click OK to commit (not shown).

IP Offices | 7 00E00706530F" & 20 ==
& BoOTP (5) [ system | Labt [ a2 [ons [ Voicemail | Telephony | Directory Services | system events | sMTP [ SMDR | Twinning | vam [ ccR | Codecs | accs |
#-¢/+ Operator (3)
=) O0EQ0T06530F LAN Settings | Vol | Network Topology |
=% System :
-~ U Network Topolagy Discovery
T4 Line (3) STUN Server Address 69.90.168.13 STUN Port 3478
< Control Unit (4)
-4 Extension (37) Firewall/NAT Type Open Intemet -
w-§  User(32)
=8 Group (1) Bindling Refresh Time (seconds) 300
-8 Short Code (65]
B Service (0) Public IP Address 0 0 0 0 Run STUN Cancel
oy RAS (1)
- Incoming Call Route (2) Public Port
8 WAN Port (0)
o= Directory (0) uoe 5050
£37 Time Profile (0)
& o
)@ Firewall Profile (1) cp
-l IP Route (4) Tis o

&m0 Account Code (0)
% License (74)
& Tunnel (0)

=-§4 User Rights (8)

- ARS (1)
# RAS Location Request (0)
8 Location (0)

Run STUN on startup

In the compliance test, the LAN1 interface was used to connect Avaya IP Office to the enterprise
private network (LAN), LAN2 was not used.
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5.3 System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details Pane, configure the following

parameters:

e Choose the Companding Law typical for the enterprise location, U-Law was used.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call
transfers to the PSTN via the SIP trunk to the service provider.

e All other parameters should be set according to customer requirements.

e Click OK to commit (not shown).

IP Offices |E

00E00706530F

[}

& BoOTP (5)
4+ Operator (3)

System | LaNL [ LAN2 | ONS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR [ Twinning [ veM [ ccR [ Codees [ Accs |

[0 00ED0T06530F

Telephony | Park & Page | Tones & Music | Ring Tones | sM

| caliog [Tu1 |

%5 System (1)
T4 Line @

“ Control Unit (4)

& Extension (37)

i Userz)

% Group (1)

8% Short Code (65)

B Service ()

o RAS (1)

@ Incoming Call Route (2)
8 WAN Port (0)

#= Directory (1)

£ Time Profile (0)

@ Firewall Profile (1)

Kl P Route (4)

B Account Code (0)

% License (74)

W Tunnel (@)

§3 UserRights (8)

‘K ARS (1)

# RAS Location Request (0)
8 Location (0)

Analogue Extensions

Ring Type 1 -
Ring Type 2 -

Restrict Analogue Extension Ringer Voltage m

Default Outside Call Sequence
Default Inside Call Sequence

Default Ring Back Sequence

w

Dial Delay Time (secs)

=)

Dial Delay Count

Default No Answer Time (secs) 15

Hold Timeout (secs) 0
Park Timeout (secs) 00
Ring Delay (secs) 5

Call Priority Promotion Time (secs) Disabled

Default Currency usD -

Disabled -

Default Name Priority

Media Connection Preservation

Companding Law
Switch Line

@ U-Law @ U-Law Line
© A-law @ A-LawLine

[] DSS Status
Auto Hold
Dial By Name

Show Account Code

[ 51 it Oft-switch ForwardTransfer

[7] Restrict Metwark Interconnect

[7] Drop External Only Impromptu Conference

[ Visually Differentiate External Call

[7] Unsupervised Analog Trunk Disconnect Handling
High Quality Conferencing

[ Strict SIPS
Digital/Analegue Auto Create User

m
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5.4 Twinning Calling Party Settings

Navigate to the Twinning tab on the Details Pane, configure the following parameters:
e Uncheck the Send original calling party information for Mobile Twinning box. This will
allow the Caller ID for Twinning to be controlled by the setting on the SIP Line (Section
5.7). This setting also impacts the Caller ID for call forwarding.
e Click OK to commit (not shown).

IP Offices |E 00E00706530F e v <>

=& BOOTP (5)
g% Operator (3)

System | LaNL [ LaN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | sMDR f Twinning |vem | ccR [ Codees [ Accs |

) 5 DOEDTO6530F [ 20 Send eriginal calling party information for Mobile Twinning |
7 % Calling party information for
L 00R00I06530F Mobile Twinning
=67 Line (3)

#-<=> Control Unit (4)
#-4 Extension 37)
#-f User32)
-3 Group (1)
-8 Short Code (65)
B Service ()
ol RAS (1)
- Incoming Call Route (2)
2 WAN Port (0)
@ Directory (0)
£ Time Profile (0)
=@ Firewall Profile (1)
= [ill P Route (4)
| Account Code (0)
% License (74)
¥ Tunnel (0)
#-§i5 UserRights (8)
=" ARS (1)
# RAS Location Request (0)
i Location (0)

5.5 Codec’s settings
For Codec’s settings, navigate to the System (1) = 00E00706530F in the Navigation Pane, select
the Codecs tab and configure the following parameters:

e The RFC2833 Default Payload field is new in IP Office release 9.0. It allows the manual

configuration of the payload type used on SIP calls that are initiated by the IP Office. The
default value 101 was used.

e Select the Codecs.
e Click OK to commit (not shown).

The Codec’s settings are shown in the screenshot below with G.711ULAW, G.711ALAW and
G.729(a) selected in prioritized order, Bell Aliant’s preferred codec order.

IP Offices IE 00E00706530F = v <]

=R BOOTP (5)
@47 Operator (3)

E00706530F |RFC2833 Default Payload 101 = |
System

00ED0706530F | Available Cedecs Default Codec Selection
e(@3) Unused Selected

‘ Systemn | LANL | LANZ | DNS |Vo|r.ama\| | Telephony | Directory Services | System Events | SMTP | SMDR |Twmnmg | VM | CCR | Codecs |ACCS |

e é;:ﬁ’:;:”(;g‘” G711 ULAW 64K G72264K sos || [6711 ULAWesk

i GI11 ALAW 64K 67231 6K3 MP-MLO G711 ALAW 64K

+ a G ) G.722 64K G.729(a) 8K CS-ACELP
roup G.729(a) 8K CS-ACELP

&9 Short Code (65)
4B Service (1)
oy RAS (1)
Incoming Call Route (2)
WAN Port (1)
Directory (0) 333
7 Time Profile (0)
- @ Firewall Profile (1)
-l IP Route (4)
i@ Account Code (0)
% License (74)
i Tunnel (0)
#-f User Rights (8)
B ARS (1)
-~ RAS Locatien Request (0)

------ i@ Location (0)

G.723.1 6K3 MP-MLQ
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5.6 IP Route

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets in order to reach the subnet where the SIP proxy is located on the Bell Aliant
network. On the left navigation pane, right-click on IP Route and select New:

e Set the IP Address and IP Mask.

e Set Gateway IP Address to the IP Address of the router used to reach the external network.

e Set Destination to LAN1 from the pull-down menu.

e Click OK to commit (not shown).

IP Offices = 172.16.5.0 FEEE AR

=& BOOTP (5) TP Route

-5 Operator G3)
B+ QOE00T06530F 1P Address 72016 5 0
System (1)

5 DDED0706530F

IP Mask 255 255 255 0

1 Line@)
Control Unit (4)
Extension (37)
w-§  User(32)

-5 Group (1)
&9 Short Code (65)
; @ Service (0)

Gateway IP Address

Destination

172 16 5 254

[Lane

Metric

o

[ Proxy ARP

+~% RAS (1)

@D Incoming Call Route (2)
2 WAN Port (0)

----- =m Directory (0)

17 Time Profile (0)

@) Firewall Profile (1)

=Bl IP Route (4)

----- #m Account Code (1)
% License (74)
----- & Tunnel (0)
-3 User Rights (8)
B ARS (1)
- RAS Location Request (0)
L8 Location (0)
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5.7 Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Bell Aliant
SIP Trunk Service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.7.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP Credentials (if applicable).

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Sections 5.7.2 —5.7.5.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the Navigation
Pane and select New => SIP Line. Then, follow the steps outlined in Sections 5.7.2 — 5.7.5.

5.7.1 Create a New SIP Trunk from Template

1. Copy the template file to the computer where IP Office Manager is installed. If needed
rename the template file to CA_BellAliant_SIPTrunk.xml. The file name is important in
locating the proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File = Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the box is checked next to Enable Template
Options. Click OK.
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Freferences | Directories Disu:u:uver':.f| Visual Preferences | Security | validation

Icon Size | Small

4

[ multiline Tabs
Enable Template Options

0]

| Ik | | Cancel | |

3. Import the template into IP Office Manager. From IP Office Manager, select Tools -
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

i~ Avaya IP Office R Manager,

File

2 ES-HE

K BOOTP(9)
i+ Operator (3)

Edit  Wiew | Tools | Help

IP Offis

SCM Zervice User Managemenk

Impart Templates in Manager
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4. In the pop-up window (not shown) that appears select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window (not
shown) will appear stating success or failure. Click OK (not shown) to continue. If
preferred, this step may be skipped if the template file is copied directly to the IP Office
template directory.

5. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New SIP Trunk From Template.

IP Offices ‘ = SIP Line - Line 17 ek - X <>
& BOOTP (3) SIP Line |Transport|SIP URI[VolP [ T38 Fax| SIP Credentials
-4 Operator (3)
Bl D0E00706530F Line Number 17 =
15 Sys
| New > romlne In Service
] | Generate SIP Trunk Template 1P DECT Line
: S Line URIType
cut CtrleX
SMLi
2 Copy Crl+C ne Check 00S
- SIP DECT Line
Paste CtrleV Call Routing Method Request UR -
MNew SIP Trunk From Template
Delete Ctrl+Del Originator number for
Validate forwarded and twinning calls
Connect To.. Crl+T Mame Priority System Default A
New from Template (Bi
ew from Template (Binary) lDwErsmn Header v] Caller ID from From header =]
Export as Template (Binary]
..... e Direciory ©) Eezociation Methad By Source P address +|  SendFromIn Clear ]
£ Time Profile (0) User-Agent and Server
@ Firewall Profile (1) Headers
-Hill IP Route (4)
..... &1 Account Code () Service Busy Response 486 - Busy Here -
W License (74) )
W Tunnel (0) Action on CAC Location Limit | Allow Voicemail -
-3 User Rights (8)
] REFER Support
¥ ARS (1) ol
# RAS Location Request (0) Incoming [mways -]
----- 5 Location (0)
Outgoing [Aways -
Method for Session Refresh [ Auto -
Session Timer (seconds) On Demand
Media Connection Preservation  [Disabled -

6. In the subsequent Template Type Selection pop-up window, select Canada from the
Country pull-down menu and select BellAliant from the Service Provider pull-down menu
as shown below. These values correspond to parts of the file name (CA_Bell
Aliant_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to finish creating
the trunk.

o] ® ==

" Tem plate Type Selection

Locale United States (US English]
Country [Canada v]
Service Provider [E{ellﬁuliant v] [ Display Al
Create new SIP Trunk ] [ Cancel ]
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Once the SIP Line is created, verify the configuration of the SIP Line with the configuration shown
in Sections 5.7.2 — 5.7.5.

Alternatively, a SIP Line can be created manually with the parameters shown below. To create a SIP
line manually, begin by navigating to Line in the Navigation Pane. Right-click and select New—

SIP Line.

5.7.2 SIP Line Tab

On the SIP Line tab in the Details Pane, configure the parameters as shown below:
e Leave the ITSP Domain Name blank.

Verify that In Service box is checked.
Verify that Check OOS box is checked. With this option selected, IP Office will use the SIP

OPTIONS method to periodically check the SIP Line.
e Verify that Call Routing Method is set to Request URI.
e Set Send Caller ID to Diversion Header.
e Check the REFER support box. IP Office will send REFER messages for calls that are
transferred back to the PSTN from IP Office endpoints. Bell Aliant support SIP REFER
messages. Under REFER Support select Always from the pull-down menu for Incoming
and Outgoing (see Note below).

Set Method for Session Refresh to Auto.
Set Session Timer (Seconds) to On Demand.

Set Media Connection Preservation to Disabled.
Default values may be used for all other parameters.
Click OK to commit (not shown).

-4 Extension (37)
= User32)
-3 Group (1)
9% Short Code (65)

B Service ()
ol RAS (1)

£8 WAN Port (0)

#x Directory ()

£ Time Profile (0)
=@ Firewall Profile (1)
=l IP Route (4)

#m Account Code (0)

% License (74)

W Tunnel (@)
#-§i5 User Rights (8)
- ARS (1)

8 Location (0)

] e Incoming Call Route (2)

# RAS Location Request (0)

Mational Prefix

" Avaya IP Office Manager 00E00706530F [9.0.300 841] [Administrator(Administrator)] N
File Edit View Tools Help
AEE Al 2%
DOE00706530F ~ Line - 17
IP Offices | i= SIP Line - Line 17 gl -8 % <
- K BOOTP (5) SIP Line [Transport| SIP URI| VolP [ T38 FaxsIP Credentials
#-¢# Operator (3)
%2 ODEDDT06530F Line Number
- System (1)
=17 Line 3) |1'rsp Demain Name | [n service 7]
e 1
e 2 URI Type P =
- Control Unit (4] Prefix Check 005 M|

Call Routing Method [Request URI v||

Country Code
International Prefix
Send Caller ID [Diversion Header v||
Association Method [By Source P address -
7] REFER Support
Incoming |Always V‘
QOutgeing |Always V‘
Method for Session Refresh ‘Auto - |
Session Timer (seconds) On Demand
Media Connection Preservation | Disabled -

Originater number for
forwarded and twinning calls

Name Priority System Default -
Caller ID from From header

Send From In Clear

User-Agent and Server
Headers

Service Busy Response

486 - Busy Here .
Action on CAC Location Limit | Allow Voicemail -
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Note: Blind Transfers to the PSTN with “REFER Support” enabled in IP Office did not work
properly. Avaya recommends to disable “REFER Support” if Blind Transfer is a required feature for
the enterprise. If Blind Transfer is not a required feature for the enterprise, and Consultative Transfer
can be used instead, Avaya recommends to enable REFER Support. Refer to Section 2.2.

5.7.3 Transport Tab
Select the Transport tab; configure the parameters as shown below:

e Setthe ITSP Proxy Address, this address was set to the inside IP Address of the Avaya

SBCE or 172.16.5.71 as shown in Figure 1.
e Setthe Layer 4 Protocol to UDP.
e Set Use Network Topology Info to LAN1 as configured in Section 5.2.
e Set the Send Port to 5060.

e Default values may be used for all other parameters.
e Click OK to commit (not shown).

IP Offices

=& BOOTP (10)
#-47 Operator (3)
7 D0E0O706530F
-y Syskem (1)
=T Line (3)
1
> 2
", 17
== Contral Unit ()
- Extension (35)
E-@  User (32)
-2y Group (1)
-8 Short Cods (64)
4B Service (0)
o RAS (1)

SIP Line - Line 17
SIP Line| Transport: |SIP URT|YoIP | T35 Fax SIP Credentials

ITSP Proxy Address  |172.16.5.71

Metwaork Canfiguration

Layer 4 Protocol upp hd

Use Network Topology Info  |LAN 1 v

Explicit DNS Server(s) o 1) o 0 1) 1] 1] o

Calls Rouke via Registrar

Separats Registrar

- Incoming Call Route (2)
¥ wanport (0)
@ Dirsctory (0)
13 Time Profile (3)
-8} Firewall Profile (1)
-l 1P Route (4)
&1 Account Code (1)
W License (74)
g Turnel (0}
s-§g User Rights (8)
- ARS (1)
# RAS Location Request (0)
& Location (D)

e - X<
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5.7.4 SIP URI Tab

A SIP URI entry needs to be created to match each incoming number that Avaya IP Office will
accept on this line. Select the SIP URI tab, and then click the Add button and the New Channel
area will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at the
top, and click the Edit... button. In the example screen below, a previously configured entry was
edited. For the compliance test, a single SIP URI entry was created that matched any DID number
assigned to an Avaya IP Office user. The entry was created with the parameters shown below:

e Set Local URI, Contact, Display Name and PAI to Use Internal Data.

e Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call routes
for this line. Similarly, associate the line to an outgoing line group using the Outgoing
Group field. The outgoing line group number is used in defining short codes for routing
outbound traffic to this line. For the compliance test, a new incoming and outgoing group 17
was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Click OK.

e Click OK again to commit (not shown).

IP Offices | i= SIP Line - Line 17 ef -8 X e <

=K BOOTP (3) [SIP Line| Transport| SIP URI[volp 738 Fax|SiP Credentials
-4 Operator (3)
=% 00E00706530F Channel Groups Via Local URT Contact Display Name PAI Credential Max Calls Add...
oo System 1) 1 17 17 L. 0: <Non... 10
27 Line @) Remove

)

#-<=> Control Unit (4)

o4 Extension 37)

©-§ User32)

=-5# Group (1)

8% Short Code (65)
B service (0)

-l RAS (1)

- Incoming Call Route (2)
B WaN Port (0)

Edit...

Edit Channel
@ Directory (0) QK

£ Time Prefile (0) Via 17216.560
@ Firewall Profile (1)
-l IP Route (4) Local URI Use Internal Data -

B Account Code (0) sl o
R License (74) Contact se Internal Data -

Cancel

:

% Tunnel (0)
=-f4 User Rights (8)
- ARS (1) PAL Use Internal Data -

Display Name Use Internal Data -

" RAS Location Request (0)
8 Location (0) Registration 0: <None> -

Incoming Group 17
Outgoing Group 17

Max Calls per Channel 10
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5.7.5 VoIP Tab

Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e Inthe sample configuration, the Codec Selection was configured using the Custom option,
allowing an explicit order of codec’s to be specified. The buttons allow setting the specific
order of preference for the codec’s to be used on the line, as shown. Bell Aliant supports
codec’s G.711ULAW, G.711ALAW and G.729(a), Bell Aliant preferred code order.

e Set Fax Transport Support to G.711 (Refer to Section 2.2).

e Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

o Verify that Allow Direct Media Path is unchecked. Testing was done with Direct Media
disabled.

e  Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on the
trunk.

e Check the PRACK/100rel Supported box, to advertise the support for reliable provisional
responses and Early Media to Bell Aliant.

e  Default values may be used for all other parameters.

e Click OK to commit (not shown).

IP Offices | = SIP Line - Line 17 gf-E X <>
=K BOOTP (5) [SIP Line| Transport|stP URI[VolP 138 Fax|siP Credentials
&g+ Operator 3)
=)-*%37 00E00706530F WVolP Silence Suppression
&% System (1)
57 Line (3) Allow Direct Media Path
- 1 -
[ ; Codec Selection |c“5t°m | V] Re-invite Supported
Unused Selected
™ 17] e i Codec Lockdown
<= Control Unit (4) 6722 64K . G711 ULAW 64K
#- 4 Extension (37) G.7231 6K3 MP-MLQ G711 ALAW 64K 7| PRACK/100rel Supported
w-§  User(32) G.729(a) 8K CS-ACELP
=3 Group (1) Force direct media with phones
g g 222‘[?%"' ©3) G711 Fax ECAN
o, RAS (1)
- Incoming Call Route (2)
8 WAN Port (0)
o= Directory (1)
£ Time Profile (0) i
+] @ Firewall Profile (1)
=l IP Route (4)
B Account Code (0) FaxTransport Support | G711
% License (74)
" Tonnd @) Location [cloud
% § User Rights (8) Call Initiation Timeout (s] |+
- ARS (1)
# RAS Location Request (0) |DTMF Support [Recasas
58 Location (0)
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5.8 Extension

In this section, an example of an Avaya IP Office Extension will be illustrated. In the interests of
brevity, not all users and extensions will be presented, since the configuration can be easily

extrapolated to other users and extensions. To add an Extension, right click on Extension then select
New -> Select H323 or SIP.

Select the Extn tab. Following is an example of extension 3040; this extension corresponds to an
H.323 extension.

IP Offices | i= H323 Extension: 8003 3040 o SR M R A
K BOOTP (5) » [ Edn VDIPT
4 Operator (3)
=37 00ED0T06530F Extension Id 3003
= System (1)
9 Line () Base Extension 3040
= Control Unit (4)
-4 Bxtension (37) Phene Password
Y s ol Dislay Type =
M 8010 1542 Reset Volume After Calls |
B 8003 3040
N — ﬁ
4 101 3043
& 1023044 Lacation [Automati( =
-, 8000 3047
- 253049 Module 0
% 8001 3050
-y, 8009 3055 Port 0
oy 264002
4 274003
: 28 4004 _||| Disable Speakerphone =]

Select the VOIP tab. Use default values on VolIP tab. Following is an example for Extension 3040;
this extension corresponds to an H.323 extension.

IP Offices

H323 Extension: 8003 3040

gk-M X ]<]|>

R BOOTP (5)
¢ Operator (3)
%37 00E00T06530F
“ System (1)
17 Line @)

“ Control Unit (4)
& Extension (37)
- 80121502

e 80111540

"w. 80101542
[P 8003 3040]

. 80023041

e 8008 3042
- 1013043
- 1023044
e 8000 3047
A 253049
- 8001 3050
. 8009 3055
A 26 4002
- 274003
- 28 4004
A& 294005
-4y 30 4006
- 314007
A 324008
4 1034011
- 104 4012
oy 105 4013
A 106 4014

m

‘Mn IVDIP |

1P Address
MAC Address

Codec Selection

Reserve License
TDM->IP Gain
IP->TDM Gain

Supplementary Services

0 0 0

00 00 00 00

00

System Default

G.722 64K
G.723.1 6K3 MP-MLQ

G711 ULAW 64K
G711 ALAW 64K
5.729(a) 8K C5-ACELP

[None

o)

[Defaut

o)

[Defaut

o)

[None

5

[ VoIP Silence Suppression

7] Eneble Feststart for
non-Avaya IP phones

Out Of Band DTMF
[] Local Tones

Allow Direct Media Path
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5.9 Users

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.7. To configure these settings, first navigate to User in the left Navigation Pane,
and then select the name of the user to be modified in the center Group Pane. In the example below,
the name of the user is Ext3040 H323.

1P Offices |§E Ext3040 H323: 3040 o SR M R A
J! BOOTP (5) Eul User Veicemail | DND | Short Cedes | Source Numbers | Telephony | Forwarding | Dialln |Vo\ca Recerding | Button Programming | Menu Programming | Mob\l\tyl Group Member * | *
% Operator (3)
=% 00ED0T06530F Name 2040 H322 -
== System (1)
19 Line @) Password seee
= Control Unit (4)
4 EBxtension 37) Confirm Password eene
Jf User3)
i NoUser Account Status Enabled -
pg RemoteManager
300 Ex3040 11323 Full Name Ext3040 H323
-4 3041 E43041 H323 Extension 3040
3042 Ext3042 H323
3043 Ext3043 Digital Email Address
3044 Ext3044 Digital
- fm 3047 E3047 SIP Locale [ -
3049 Ext3049 Fax
[ 3055 Ext3055 H323 Priority s -
4002 Extn4002
1003 End00s Systern Phone Rights [None -
4004 Extnd004 ACCS Agent Type None
4005 Extn4005
4006 Extnd006 ||| Profite [Basic User -
4007 Extn4007 E
4008 Extn4008 [C] Receptionist L

4011 Extnd011
4012 Extnd012
4013 Extnd013 [T] Enable one-X Portal Services
4014 Extnd014
4015 Extnd015
4016 Extnd016 [C] Enable Remote Worker
4017 Extnd017
4018 Extnd018 Enable Flare
4019 Extnd019
4020 Extnd020

Enable Softphone

Enable one-X TeleCommuter

Enable Mobile VoIP Client

4021 Extnd021 Send Mobility Email
4022 Extnd022
4023 Extnd023 [7] Ex Directory
@ 4024 Bdnd024
e 3050 5ip3050
2 Group (1) Device Type ﬁ Avaya 9620
8% Short Code (65)
B Service ) User Rights

& RAS (1) User Rights view [User data -
2 Incoming Call Route (2)
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In the example below, the name of the user is “Ext3047 SIP”. This is an Avaya IP Office Softphone
user, set the Profile to Power User and check Enable Softphone.

-{m RemoteManager
3040 Ex3040 H323
~fm 3041 E43041 H323
3042 B43042 H323
3043 Ex43043 Digital
044 £x43044 Digital
3049 Ext3049 Fax
[ 3055 Ext3055 H323
~§ 4002 Bnd002
4003 Extnd003
4004 Extn4004
4005 Extn4005
4006 Extnd006
4007 Extnd007
4008 Extn4008
4011 Extnd011
4012 Extnd012
4013 Extnd013
4014 Extnd014
4015 Extnd015
4016 Extn016
4017 Extnd017
4018 Extnd018
4019 Extnd019
4020 Extnd020
4021 Extnd021
4022 Extnd022
4023 Extnd023
~§ 4024 Bdnd024
- 3030 sip3050
% Group (1)
8% Short Code (65)
B Service ()
o RAS (1)
@ Incoming Call Route (2)

L.L

m

Full Name

Extension

Email Address
Locale

Priority

Systern Phone Rights
ACCS Agent Type

Profile

y

Device Type

User Rights

User Rights view

Softclient 3047

3047

[

5

[ane

Mene

[Power User

[C] Receptionist
Enable Softphone

Enable one-X Portal Services
Enable one-X TeleCommuter

Enzble Remote Worker
Enable Flare

Enzble Mobile VoIP Client
[ Send Mobility Email

[C] Ex Directory

Unknown SIP device

[User data

IP Offices |E Ext3047 SIP: 3047 FECIE A
JS BOOTP B) * || User |Vo|cama\| | DND | Short Codes | Source Numbers | Telephony | Forwarding | Dial In |Vo\ce Recording | Button Programming | Menu Programming | Mob\l\tyl Group Member ¢ | *
4 Operator (3)
%7 00EQQT06530F Mame E3047 SIP -
= System (1)
19 Line @) Passwaord sess
= Control Unit (4]
& Extension (37) Confirm Password .
2§ User32)
3 NeUser Account Status Enabled -

n

Select the Voice Mail tab. The following screen shows the VVoicemail tab for the user with extension
3040. The Voicemail On box is checked. Voicemail password can be configured using the
Voicemail Code and Confirm Voicemail Code parameters. In the verification of these Application
Notes, incoming calls from Bell Aliant to this user were redirected to VVoicemail Pro after no answer.
Voicemail messages were recorded and retrieved successfully. Voice mail navigation and retrieval

were performed locally and from PSTN telephones to test DTMF using RFC 2833.

“ Control Unit (4)

& Extension (37)

i Userza)

NoUser

RemoteManager
3040 Ext3040 H323

= 3041 Ex3041 H323

3042 Bx43042 H323

3043 Ext3043 Digital

3044 Ext3044 Digital

| 3047 EXt3047 SIP

3049 Ext3049 Fax

- 3055 EXt3055 H323

4002 Extn4002

4003 Extnd003

4004 Extnd004

4005 Extn4005

4006 Extn4006

4007 Extnd007

4008 Extn4008

4011 Extnd011

m

Woicemail Email

® Off ) Copy ( Forward

DTMF Breakout

Reception / Breakout (DTMF 0)
D

Breakout (DTMF 2)

D

Breakout (DTMF 3)

D

Alert

System Default

System Default

System Default )

[ Voicemail Ringback
Voicemail Email Reading

[ UMS Web Services

IP Offices | = Ext3040 H323: 3040 gf-® X v <>
4 sooTP () * | | user [ Veicemail | DND | short Codes | Source Numbers | Telephony | Forwarding | Dialln | Voice Recording | Button Programming | Menu Programming | Mebility | Group Member « | »
& Operator (3)
£ "5 00EDD706530F Voicemail Code wrenee Voicemail On
@ System (1)
T4 Line (3) Confirm Voicemail Code  sssese Voicemail Help
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Select the Mobility tab. In the sample configuration user 3040 was one of the users configured to
test the Mobile Twinning feature. The following screen shows the Mobility tab for User 3040. The
Mobility Features and Mobile Twinning boxes are checked. The Twinned Mobile Number field
is configured with the number to dial to reach the twinned telephone, including the dial access code
“9”, in this case 917864571234. Other options can be set according to customer requirements.

IP Offices |

7

Ext3040 H323: 3040* gh-E X e|<]|>

& BOOTP (5 o
4 Operator (3)

User |Vo|cema\| | DND |Short Codes | Source Numbers | Telephony | Forwarding | Dialln |Vo\ce Recording | Button Programming | Menu Programmmgl Mohbility |Group Member ¢ |+

=43y 00ED0T06530F
= System (1)
7 Line (3)
= Control Unit (4)
4 Bxtension (37)
9§ User32)
- NoUser
~{m RemoteManager
3040 Ex3040 H323
-4 3001 3041 H3Z3
3042 B43042 H323
3043 Ex43043 Digital
3044 Ext3044 Digital
~fm 3047 Ex3047 SIP
3049 Ext3049 Fax
[ 3055 Ext3055 H323
~§ 4002 Extnd002
4003 Extnd003
4004 Extn4004
4005 Extn4005
4006 Extnd006
4007 Extnd007
4008 Extn4008
4011 Extnd011
4012 Extnd012
4013 Extnd013
4014 Extnd014
4015 Extnd015
4016 Extnd016
4017 Extnd017

m

[] Internal Twinning

<None>
1

Twin Bridge Appearances

Twin Coverage Appearances

Twin Line Appearances

Mobility Features
Mobile Twinning

T.wmne.d MD.hI\E Number 917864571234
(including dial access code)

Twinning Time Profile |<None»

Mobile Dial Delay (secs) 2
Mobile Answer Guard [secs) 0
[] Hunt group calls eligible for mobile twinning
[7] Forwarded calls eligible for mobile twinning
[] Twin When Logged Out

[] ene-X Mobile Client

Mobile Call Control

[Z] Mobile Callback
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To program a key on the telephone to turn Mobil Twinning on and off, select the Button
Programming tab on the user, then select the button to program to turn Mobil Twinning on and off,
click on Edit = Emulation = Twinning. In the sample below, button 4 was programmed to turn

Mobil Twinning on and off on user 3040.

IP Offices | F Ext3040 H323: 3040 gf-® X v <>
? “ gig:ﬂ‘f()}) * | | user | Voicemail | DND [ Short Codes | Source Mumbers | Telephony | Forwarding | Dialn | Voice Recording | Button Programming | Menu Progremming | Mobility | Group Membe « | +
7 00EDD706530F Button.. Label Action Action Data o Remove
- System (1)
#-T7 Line (3) 1 Appearance a=
- Control Unit (4] 2 Appearance b= Edit...
4 Extension (37) 3 Appearance = E
4 e o ——
Nolser
RemoteManager £ Paste
[ =040 Ea3040 H3Z3) €
g 3041 Ex3041 H333 7
3042 Ext3042 H323 8
3043 Ext3043 Digital 9
3044 Ext3044 Digital o
{3047 Ext3047 SIP
3049 Ext3049 Fax o
- 3055 3055 H323 12
4002 Extnd002 13
4003 Extnd003 14
4004 Extnd004 =
4005 Extnid005
4006 Extnd006 -
4007 Extnd007 E g
4008 Extnd008 18
4011 Extnd011 19
4012 Extrd012 2
4013 Extnd013 o
4014 Extnd014
4015 Extnd015 2
4016 Extnd016 23
4017 Extnd017 24 Display all buttons
4018 Extnd018 25
4019 Extnd019 -
4020 Extnd020
4021 Extnd021 2
4022 Extn4022 28
4023 Extnd023 2
4024 Extnd024 Edit Button
[ 3050 sip3050
= @8 Group (1) [Button . 4] MOK
8% Short Code (65)
B Service (0) Label ancel
ol RAS (1)
@ Incoming Call Route (2) |~L\<tiDn Twinning | [I]
2 WAN Port (0)
= Directory (0] Action Data
£7 Time Profile (0)
& Firewall Profile (1)

Select the SIP tab, the values entered for the SIP Name and Contact fields are used as the user part
of the SIP URI in the “From” and “Contact” headers for outgoing SIP trunk calls. In addition, these
settings are used to match against the SIP URI of incoming calls without having to enter this number
as an explicit SIP URI for the SIP line (Section 5.7). The example below shows the settings for user
“Ext3040 H323”. The SIP Name and Contact are set to one of the DID numbers assigned to the
enterprise by Bell Aliant. In the example, DID number 5066948000 was used. The SIP Display

Name (Alias) parameter can optionally be configured with a descriptive name.

If all calls involving this user should be considered private, then the Anonymous box may be

checked to withhold the Caller ID information from the network.

IP Offices | = Ext3040 H323: 3040

ek - X< ]|>

=& BOOTP (5 o

G- O tor () Telephony | Forwarding | DialIn |Vo\ce Recording | Button Pregramming | Menu Pregramming | Moblhtyl Group Membership Announcementsl SIP
" Operator

| Personal Directory ‘

“= 00E00706530F

-5 System (1)

47 Line (3)

#-“= Control Unit (4)

#I- 4 Extension (37)

0§ User(3)
g NoUser
B RemateManager
- [§_3090 Ex3040 H323]
i 3041 E43041 H323

SIP Name 5066348000
SIP Display Name (Alias) B3040 H323

Contact 5066948000

B Anonymous
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5.10 Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc., within the IP Office system.

In a scenario like the one used for the compliance test, only one incoming route is needed, which
allows any incoming number arriving on the SIP trunk to reach any predefined extension in IP
Office. The routing decision for the call is based on the parameters previously configured for Call
Routing Method and SIP URI (Section 5.7) and the users SIP Name and Contact, already
populated with the assigned Bell Aliant DID numbers (Section 5.9).

From the left Navigation Pane, right-click on Incoming Call Route and select New.

On the Details Pane (not shown), under the Standard tab, set the parameters as show bellow:
e Set Bearer Capacity to Any Voice.
e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.7.
e Default values may be used for all other parameters.

IP Offices IE 17 IR
=& BOOTP (5) Standard | Voice Recording | Destinations |
@ Operator (3)
=)+ 00E00706530F
- System (1) - -
e Bearer Capability [Any Veice
<= Control Unit (4) Line Group 1D Y -
T @ Extension (37)
o User(32) Incoming Number
i Group (1) )
8% Short Code (65) Incoming Sub Address
Service (0) .
. E RS 1) Incoming CL1
=@ Incoming Call Route (2) Locale | 3
0 Priarity [1-Low -]
8 WAN Port (0)
= Directory (0) Tag
£ Time Profile (0)
= @ Firewall Profile () Hold Music Source [system Source -
=l P Route (4) ) )
Bm Account Code (0) Ring Tone Override None -
% License (74)
& Tunnel (@)
#-§5 User Rights (8)
) ARS (1)
@ RAS Location Request (0)
1 Location (0)
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e Under the Destinations tab, enter ““.” for the Default VValue. This setting will allow the call
to be routed to any destination with a value on its SIP Name field, entered on the SIP tab of
that User, which matches the number present on the user part of the incoming Request URI.

e Click OK to commit (not shown).

IP Offices |E 17 I

=K BOOTP (5) | standard | Voice Recording | Destinations
#)-¢% Operator (3)

27 00E00706530F

57 System (1) v [Default Value ; [-1 [-]

=7 Line (3)

#-<=r Control Unit (4)

#-4& Extension (37)

©-§ User32)

-5 Group (1)

-9 Short Code (65)

B Service (0)
- alfy RAS (1)
=4 Incoming Call Reute (2)

TimeProfile Destination Fallback Extension

o
B WAN Port (0)
#= Directory (1)
£ Time Profile ()
)@ Firewall Profile (1)
=il IP Route (4)
&m0 Account Code (0)
% License (74)
&4 Tunnel (0)
=-§4 User Rights (8)
- ARS (1)
@ RAS Location Request (0)
8 Location (0)
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5.11 Outbound Call Routing

For outbound call routing, a combination of system short codes and Automatic Route Selection
(ARS) entries are used. With ARS, features like time-based routing criteria and alternate routing can
be specified so that a call can re-route automatically if the primary route or outgoing line group is
not available. While detailed coverage of ARS is beyond the scope of these Application Notes, and
alternate routing was not used in the reference configuration, this section includes some basic screen
illustrations of the ARS settings used during the compliance testing.

5.11.1 Short Codes and Automatic Route Selection

To create a short code to be used for ARS, right-click on Short Code on the Navigation Pane and
select New. The screen below shows the short code 9N created. Note that the semi-colon is not used
here. In this case, when the Avaya IP Office user dials 9 plus any number N, instead of being
directed to a specific Line Group 1D, the call is directed to Line Group 50: Main, which is
configurable via ARS.

IP Offices = 9N: Dial o B X[ o>
936 ~ |[ short code |

..... 9% TNz

----- X 33N Code 9N
% 39

..... o 40 Feature Dl I

..... 9% 41
ox 2 Telephone Number N
% -3

..... 9% 41
% 45Nz
% =46

..... o 47 Force Account Code

..... 9% 43
% =19

Line Group ID 50: Main -

Locale -

..... 9% *50

..... o 51
% 52
% 53N

..... o 55

..... B 57N
% 67N,

..... B <70 N2

..... % TN
9% "9000"
9 9N

..... o 02N
9% *%9
9% "DSSN

..... 9% “sDM

..... 9% “SKN
9% ON;

..... 1N

..... 9% 2N,
9% 8N,

..... ENEQD
----- 4B Service (0)
(ol RAS (1)
-4 Incoming Call Route (2)
----- 2 WAN Port (0)

=u Directory (0)

{T“ Time Profile (0)
@ Firewall Profile (1)
a-Jill IP Route (4)
&1 Account Code (0)
----- % License (74)
----- & Tunnel (0)
i-fig User Rights (8)
T"'.{ ARS (1)

i@ RAS Location Request (0)

i@ Location (0) il
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The following screen shows the example ARS configuration for the route Main. Note the sequence
of Xs used in the Code column of the entries to specify the exact number of digits to be expected,
following the access code and the first digit on the string. This type of setting results in a much
quicker response in the delivery of the call by IP Office. The first example highlighted below shows
that for calls to area codes in the North American Numbering Plan, the user dialed 9, followed by 11
digits, starting with a 1. The second example highlighted shows a seven digit number starting with a
6, the user dialed 9, followed by the local number (e.g., 96941234).

IP Offices IE Main I
K BoOTP (5) ARS
4+ Operator (3)
- 00E00T06530F ARS Route Id 50 Secondary Dial tone
= System (1)
1ine)
= Control Unit () Route Name Main %
& Extension (37)
§ userz2) Dial Delay Time System Default (3) Check User Call Barring
3 Group (1)
8% Short Cade (65)
% ;Zz'a? © In Service Qut of Service Route [<None> v]
@ Incoming Call Route (2) l
B WaN Port (0)
@ Directory (0) . )
75 Time Profile () Time Profile <None> —_ & OutofHours Route [<Nones -
& Firewall Profile (1) l
Al 1P Route (4)
B Account Code (0)
%= License (74) Code Telephone Number Feature Line Group ID Add...
?E”””;' (ﬂi DXOOOO0O000K...  ON Dil 17
- A;\Esr e BXO0CUOOK aN Dial 17 -REmove
[ 100U 1N Dial 17
" RAS Location Request (0) N; N"®172.16.571" Dial 17 E
B8 Location () [Exc0oan N Dl 17 ]
KKK 3N Dial 17
« i
3 l
E —— 4 AlternateRoute <None> -
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5.12 Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling party
number in the “From” and “Contact” headers of the SIP INVITE message with “restricted” and
“anonymous” respectively. Avaya IP Office can be configured to use the P-Preferred-ldentity (PPI)
or P-Asserted-ldentity (PAI) header to pass the actual calling party information for authentication
and billing. By default, Avaya IP Office will use PPI for privacy. For the compliance test, PAI was
used for the purposes of privacy.

To configure Avaya IP Office to use PAI for privacy calls, navigate to User > NoUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.

#)-“= Contral Unit (4)
-4 Extension (37)
=-§ User(32

g Nobser]

RemoteManager

IP Offices = NoUser: * FEEIE IR
z- & EOOTE 533) * | [ user | Voicemail | DND [ Short Codes | Source Numbers | Telephony | Forwarding | Dialn | Voice Recording | Butten Programming | Menu Progremming | Motilty | Group Membe « | +
w3 Operator
%7 00E00706530F Source Number Add...
% System (1)
&7 Line (3) Remove

Edit...

At the bottom of the Details Pane, the Source Number field will appear. Enter

SIP_USE_PAI_FOR_PRIVACY. Click OK (not shown).

MNew Source Number

Source Number

SIP_USE_PAI_FOR_PRIVACY |

The SIP_USE_PAI_FOR_PRIVACY parameter will appear in the list of Source Numbers as

shown below.

IP Offices

NoUser:

= S0 N SR

=& BOOTP (5)
g% Operator (3)
57 00ED0706530F
& System (1)
L 00EO0T06530F
#-F7 Line (3)
&= Control Unit (4)
-4 Extension (37)

o f User32
-4 RemoteManager

»

User | Voicemail | DND [ Short Cades| Source Numbers | Telephony | Forwarding | Dialin | Voice Recording | Button Programming | Menu Progremming | Moty | Group Member « | +

Source Mumber

SIP_USE_PAI_FOR_PRIVACY

Add...

Remove

Edit...
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5.13 Save Configuration

When desired, send the configuration changes made in Avaya IP Office Manager to the Avaya IP
Office server in order for the changes to take effect.

Navigate to File->Save Configuration in the menu bar at the top left of the screen to save the
configuration performed in the preceding sections.

Once the configuration is validated, a screen similar to the following will appear, with either the
Merge or the Immediate radio button chosen based on the nature of the configuration changes made
since the last save. Note that clicking OK may cause a service disruption due to system reboot. Click
OK if desired.

r:

Save Configuration E =] @

IP Office Settings
00E0O706530F

Configuration Reboot Mode
@ Merge

Immediate

When Free

Tirmed

Reboat Time

11:20

Call Barring

OK l | Cancel | | Help
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6. Configure the Avaya Session Border Controller for Enterprise

This section covers the configuration of the Avaya SBCE. It is assumed that the initial installation of
the Avaya SBCE and the assignment of the management interface IP Address have already been
completed; hence these tasks are not covered in these Application Notes. For additional information
on these configuration tasks, see References Error! Reference source not found., Error!
Reference source not found. and Error! Reference source not found. in Section 10.

The configuration of the Avaya SBCE covers two major components, the Trunk Server for the
service provider and Call Server for the enterprise. Each component consists of a set of Global
Profiles, Domain Policies and Device Specific Settings. The configuration was defined using the
Avaya SBCE web user interface as described in the following sections.

Note: During the next pages and for brevity in these Application Notes not every provisioning step
will have a screenshot associated with it.

6.1 Log into the Avaya Session Border Controller for Enterprise

Use a Web browser to access the Avaya SBCE Web interface, enter https://<ip-addr>/sbc in the
address field of the web browser, where <ip-addr> is the management IP address.

Enter the appropriate credentials then click Log In.

Log In
Usemame:
Password: [reeceesed]
Login
Session Border Controller This system is restricted solely to authorized users for legtimate
f business purposes only. The actual or attempted unauthorized access,

for Enterp”se use or modifications of this system is strictly prohibited. Unauthorized
users are subject to company discipinary procedures and or criminal
and civil penatties under state, federal or other applicable domestic and
foreign laws.
The use of this system may be monfored and recorded for
administrative and sscurity reasons. Anyone accessing this system
expressly consents to such montoring and recording, and is advised
that if it reveals possible evidence of criminal activity, the evidence of
such activity may be provided to law enforcement officials.
Al users must comply with all corporate instructions regarding the
protection of information assets.
@2011- 2013 Avaya Inc. Al rights reserved
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The Dashboard main page will appear as shown below.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Dashboard
Backup/Rest
ackup/restore System Time 06:33:28 AM GMT Refresh  EMS
System Management
» Global Parameters Version St A S EEE
» Global Profiles Build Date Wed May 28 09:21:02 UTC 2014
> SIP Cluster

» Domain Policies
> TLS Management None found. Avaya SBCE: No Server Flow Matched for Incoming Message
» Device Specific Settings Avaya SBCE: No Server Flow Matched for Incoming Message
Avaya SBCE: No Server Flow Matched for Incoming Message
Avaya SBCE: No Server Flow Matched for Incoming Message

Avaya SBCE: No Server Flow Matched for Incoming Message

Add

No notes found.

To view the system information that has been configured during installation, navigate to System
Management. A list of installed devices is shown in the right pane. In the compliance testing, a
single Device Name Avaya SBCE was already added. To view the configuration of this device,
click the View as shown in the screenshot below. Note that the Management IP was blurred out for
security reason.

Alarms  Incidents  Statistcs Logs  Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard System Management

Administration

Backup/Restore

System Management Devices H Updates || SSL VPN H Licensing |
> Global Parameters Device Name Management IP Version

{Serial Number)

> Global Profiles
Avaya SBCE . , —
> SIP Cluster :IPC¥310351321. 6.21.Q16 Commissioned Reboot Shutdown Restart Application [View

> Domain Policies

Edit Delete

> TLS Management

> Device Specific Settings
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The System Information screen shows Network Settings, DNS Configuration and
Management IP information provided during installation and corresponded to Figure 1. The Box
Type was set to SIP and the Deployment Mode was set to Proxy. Default values were used for all

other fields.

To view the network configuration assigned to the Avaya SBCE, click View on the screen above.

The System Information window is displayed.

System Information: Avaya SBCE X

r ‘General Configuration

Appliance Mame
Box Type SIP

Deployment Mode  Proxy

Avaya SBCE

Device Configuration
HA Mode No

Two Bypass Mode Mo

r Network Configuration

Public IP Netmask Gateway Interface
172.16.5.71 172.16.5.71 255.255.255.0 172.16.5.254 Al
172.16.5.199 172.16.5.199 255.255 2550 172.16.5.200 B1

r DN5 Configuration Management IP(s)
Primary DNS 172.16.5.102 IP
Secondary DNS
DMS Location DMZ
DNS Client IP 172.16.5.71

On the previous screen, note that the Al correspond to the inside interface (toward IP Office) and B1
correspond to the outside interface (toward the Service Provider) of the Avaya SBCE. The
management IP was blurred out for security reasons.

IMPORTANT! — During the Avaya SBCE installation, the Management interface, (labeled
“M1”), of the Avaya SBCE must be provisioned on a different subnet than either of the Avaya
SBCE private and public network interfaces (e.g., A1 and B1). If this is not the case, contact
your Avaya representative to have this resolved.
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6.2 Global Profiles

The Global Profiles Menu, on the left navigation pane, allows the configuration of parameters across
all Avaya SBCE appliances.

6.2.1 Server Interworking profile - Avaya-IPO

Interworking Profile features are configured to facilitate interoperability of implementations between
enterprise SIP-enabled solutions and different SIP trunk service providers.

Several profiles have been already pre-defined and they populate the list under Interworking
Profiles on the screen below. Since modifying a default profile is generally not recommended, for
the Avaya-IPO interworking profile the default avaya-ru profile was duplicated, or “cloned”, and
then modified to meet specific requirements for the enterprise SIP-enabled solution.

On the left navigation pane, select Global Profiles - Server Interworking. From the
Interworking Profiles list, select avaya-ru. Click Clone Profile on top right of the screen (not
shown).

Enter the new profile name in the Clone Name field, the name of Avaya-1PO was chosen in this
example. Click Finish (not shown).
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For the newly created Avaya-1PO profile, click Edit at the bottom of the Advanced tab (not

shown):

e Uncheck Include End Point IP for Context Lookup.
e Uncheck AVAYA Extensions.
e Leave other fields with their default values.
e Click Finish.
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Call-Info NAT [l
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| AvAYA Extensions &

NORTEL Extensions ll

Diversion Manipulation 0

Diversion Header URI

Metaswitch Extensions [l

Reset on Talk Spurt =

Reset SRTP Context on Session Refresh  []

Has Remote SBC

Route Response on Via Port ]

Cisco Extensions ]

)

Editing Profile: Avaya-IPO X
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The following screen capture shows the General tab of the newly created Avaya-1PO Server
Interworking Profile.

Alarms  Incidents  Stafistics Logs  Diagnostics  Users Seftings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: Avaya-IPO
Backup/Restore
Interworking Profi Click here to add a description.
System Management
52100
> Global Parameters General | | Timers | | URI Manipulation | [ Header Advanced
4| Global Profiles avaya-ru =
o3 Potles i
omain Do! o
e Hold Support NONE
Fingerprint
cisco-ccm
Server Interworking 180 Handling None
Phane Interworking cups 181 Handling None
Wedia Forking Sipera-Halo 182 Handling None
Routing OCS-FrontEnd-Server 183 Handling Nane
Server Configuration
Topology Hiding Avaya-SM Refer Handling Mo
Signaling Manipulation SP-General URI Group None
URI Groups Avaya-CS1000 3o Handling No
> SIP Cluster :
Diversion Header Support Mo
Avaya-IPO PPt
» Domain Policies P —— -
elaye andling o
> TLS Management Avaya-CM =
> Device Specific Settings Test Rednvite Handling No
T.38 Support Mo
URI Scheme SIP
Via Header Format RFC3261
Privacy Enabled Mo
User Name
P-Asserted-ldentity MNo
P-Preferred-ldentity Mo
Privacy Header
DTMF
DTMF Support Mone o
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The following screen capture shows the Advanced tab of the newly created Avaya-1PO Server
Interworking Profile.

Alarms  Incidents  Statistics

Logs  Diagnostics

Users

Seftings Help  Log Out

b

>

b

b

Dashboard
Administration
Backup/Restore
System Management

Global Parameters

4 |Global Profiles

Domain DoS
Fingerprint

Server Interworking
Phone Interworking
Media Forking

Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups

SIP Cluster

Domain Policies
TLS Management
Device Specific Settings

Session Border Controller for Enterprise

Interworking Profiles: Avaya-IPO

Add

Interworking Profiles Click here to add a description.

52100
avaya-ru
QOCS-Edge-Senver
cisco-cem

cups

Sipera-Halo
QCS-FrontEnd-Server
Avaya-SM
SP-General
Avaya-C51000

Avaya-CM

Test

i H Advanced |

AVAYA

[ Rename H Clone H Delete ]

General | | Timers | | URI Manipulati | ‘ Header
Record Routes Both
Topology Hiding: Change CalHD No
Call-Info NAT No
Change Max Forwards Yes

| Include End Point IP for Context Lookup Nul
OCS Extensions No
|AVAYA Extensions No |
NORTEL Extensions No
Diversion Manipulation No
Metaswitch Extensions No
Reset on Talk Spurt No
Reset SRTP Context on Session Refresh No
Has Remote SBC Yes
Route Response on Via Port No
Cisco Extensions No

HG; Reviewed:
SPOC 10/15/2014

Solution & Interoperability Test Lab Application Notes
©2014 Avaya Inc. All Rights Reserved.

42 of 94
BellAIPO90ASBCE



6.2.2 Server Interworking profile — SP-General

A second Server Interworking profile named SP-General was created for the Service Provider, note
that the Add button was used to add this profile.

On the left navigation pane, select Global Profiles - Server Interworking. From the
Interworking Profiles list, select Add (not shown).

Enter the new profile name, the name of SP-General was chosen in this example. Accept the default
values for all fields by clicking Next and then click Finish (not shown).

The following screen capture shows the General tab of the newly created SP-General Server
Interworking Profile.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: SP-General
Administration Add [ Rename H Clone H Delete ]
Backup/Restore
Interworking Profiles Click here to add a description.
System Management
cs2100
> Global Parameters General || Timers || URI Manipulati H Header i i H Ad d |
4 |Global Profiles avaya-ru 7
pa Pt £
omain Do -Edge-
CES eI Hold Support NONE
Fingerprint
clsco-ccm .
Server Interworking 180 Handling None
Phone Interworking CEES 181 Handling None
Media Forking Sipera-Halo 182 Handling None
Rotting OCS-FrontEnd-Senver 183 Handling MNone
Server Configuration
Topolagy Hiding Avaya-SM Refer Handling Mo
Signaling Manipulation SP-General URI Group None
URI Groups Avaya-CS1000 3xx Handling No
> SiP Cl.uster. . Avaya-PO Diversion Header Support Mo
> Domain Policies N ———— -
elaye andling o
> TLS Management Avaya-CM =
» Device Specific Settings Redniite Handling Ho
T.38 Support No
URI Scheme SIP
Via Header Format RFC3261
Privacy Enabled Mo
User Name
P-Asserted-ldentity Mo
P-Preferred-ldentity Mo
Privacy Header
DTMF
DTMF Support MNone -
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The following screen capture shows the Advanced tab of the newly created SP-General Server
Interworking Profile.

Alarms  Incidents  Statistics

Logs  Diagnostics

Users

Seftings Help  Log Out

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters
‘
Domain DoS
Fingerprint
Server Interworking
Phone Interworking
Media Forking

Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups

> SIP Cluster

> Domain Policies
» TLS Management
» Device Specific Settings

Session Border Controller for Enterprise

Interworking Profiles: SP-General

Add

Interworking Profiles Click here to add a description.

cs2100

avaya-ru
QOCS-Edge-Senver
cisco-cem

cups

Sipera-Halo
OCS-FrontEnd-Server
Avaya-SM
Avaya-C51000
Avaya-IPO

Avaya-CM

General || Timers || URI Manipulati H Header

i ‘ ;Advanced |

AVAYA

[ Rename H Clone H Delete ]

Record Routes

Topology Hiding: Change CalHD
Call-Info NAT

Change Max Forwards

Include End Point IP for Context Lookup
OCS Extensions

AVAYA Extensions

NORTEL Extensions

Diversion Manipulation

Metaswitch Extensions

Reset on Talk Spurt

Reset SRTP Context on Session Refresh
Has Remote SBC

Route Response on Via Port

Cisco Extensions

Both

HG; Reviewed:
SPOC 10/15/2014

Solution & Interoperability Test Lab Application Notes
©2014 Avaya Inc. All Rights Reserved.

44 of 94
BellAIPO90ASBCE



6.2.3 Routing Profiles

Routing profiles define a specific set of routing criteria that are used, in conjunction with other types
of domain policies, to determine the route that SIP packets should follow to arrive at their intended
destination.

Two Routing Profiles were created in the test configuration, one for inbound calls, with IP Office as
the destination, and the second one for outbound calls, which are sent to the Service Provider SIP
trunk.

To create the inbound route with IP Office as the destination, from the Global Profiles menu on the
left-hand side:

e Select the Routing tab (not shown).

e Select Add (not shown).

e Enter Profile Name: Route_to_IPO.

e Click Next.

Routing Profile

|F'ruﬁ|e MName Route_to_IPO |
MNext
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On the next screen, complete the following:
e Next Hop Server 1: 172.16.5.60 (IP Office IP address).
e Check Routing Priority Based on Next Hop Server.
e Check Outgoing Transport: UDP.
e Click Finish.

Routing Profile X

Each URI group may only be used once per Routing Profile.
Next Hop Routing

URI Group * |Z|
Next Hop Server 1
1P, IF’:PDrtPDBmain, or Demain: Port 1?216560

MNext Hop Server 2

IP, IF:Port, Domain, or Demain: Port

Routing Priority based on
Next Hop Server

=

Use Next Hop
for In Dialog Messages

Ignore Route Header
for Messages Outside Dialog

NAPTR

O o o O

SRV
COutgoing Transport O T8 O TCP

[ Back | || Finish ||

Note: UDP is the recommended transport protocol to be used on the connection between the Avaya
SBCE and IP Office. However, TCP can be used instead if necessary.
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The following screen shows the newly created Route_to_IPO Routing Profile.

Alarms  Incidents  Statistics Logs Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Routing Profiles: Route_to_IPO

Administration [ Rename ][ Clone ][ Delete ]

Backup/Restore
Routing Profiles Click here to add a description.
System Management

> Global Parameters GEZEE Routing Profile
4| Global Profiles Route_to_SM
Add

Domain DoS Route_to_SP

Fingerprint Priority URI Group MNext Hop Server 1 Next Hop Server 2
Route_to_CM

Server Interworking 1 = 172.16.5.60 - View Edit
Route_to_CS1000

Phone Interworking

Media Forking

Server Configuration

Topology Hiding
Signaling Manipulation
URI Groups

> SIP Cluster

> Domain Policies

> TLS Management

> Device Specific Settings

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 47 of 94
SPOC 10/15/2014 ©2014 Avaya Inc. All Rights Reserved. BellAIPO90ASBCE



Similarly, to create the outbound route with the Service Provider as the destination, from the Global
Profiles menu on the left-hand side:

e Select Add.

e Enter Profile Name: Route_to_SP.

e Click Next.

e Next Hop Server 1: 142.125.72.11 (IP address for Service Provider’s SIP Proxy).
e Check Routing Priority Based on Next Hop Server.

e Check Outgoing Transport: UDP.

e Click Finish.

The following screen shows the newly created Route_to_SP Routing Profile.

Alarms  Incidents  Statistics  Logs  Diagnostics  Users

Settings  Help

Log Out

Session Border Controller for Enterprise AVAYA
Dashboard Routing Profiles: Route_to_SP
Administration Add [ Rename ][ Clone ][ Delete ]
Backup/Restore
System Management
» Global Parameters defauit Routing Profile
4 |Global Profiles Route_ta_SM —
Domain DoS Route_to_SP
Fin - Priority URI Group Next Hop Server 1 Next Hop Senver 2
gerprint
Route_to_CM
Server Interworking - - 1 ® 1421257211 View Edit
Phone Interworking Route_to_C51000

Media Forking

Route_to_IPO

Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups

> SIP Cluster

» Domain Policies

» TLS Management

» Device Specific Settings
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6.2.4 Signaling Manipulation

The Signaling Manipulation feature of the Avaya SBCE allows an administrator to perform a
granular header manipulation on the headers of the SIP messages, which sometimes is not possible
by direct configuration on the web interface. This ability to configure header manipulation in such a
highly flexible manner is achieved by the use of a proprietary scripting language called SigMa.

The script can be created externally as a regular text file and imported in the Signaling Manipulation
screen, or they can be written directly in the page using the embedded Sigma Editor. In the reference
configuration, the Editor was used. A detailed description of the structure of the SigMa scripting
language and details on its use is beyond the scope of these Application Notes. Consult [6] on the
References section for more information on this topic.

A Sigma script was created during the compliance test to hardcode the PAI with the first DID
number in the DID group provided by Bell Aliant. This was required in order to make outbound calls
from IP Office to the PSTN and for the correct number to be displayed at the PSTN (CallID).

On the left navigation pane, select Global Profiles & Signaling Manipulation. From the Signaling
Manipulation Scripts list, select Add (not shown).

e For Title enter a name, the name Hardcode PAI was chosen in this example.

e Enter the script as shown on the screen below (Note: The script can be copied from

Appendix A).
e Click Save.

Signaling Manipulation Editor AVAYA
Title Hardcode PAI

/fThe 5BC will hardcode the PAI with the first DID number in the DID group,

/fWhich is also used for 5IF Trunk Registration.

//This is required in order to make outbound calls (IFQ0-->PSIN) and for

//the correct number to be displayed at the PSTN.

within session "INVITE"

{

act on request where $DIRECTION="OQUTBOUND" and $ENTRY POINT="F0OST ROUTING™
$HEADERS ["P-Asserted-Identity™] [1].URI.USER = "506694E5000";
}

}
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The following screen capture shows the newly added Hardcode PAI SigMa script.

Alarms  Incidents  Statistics  Logs  Diagnostics

Session Border Controller for Enterprise

Dashboard Signaling Manipulation Scripts: Hardcode PAI
Administration Up\oad Add

Backup/Restore

System Management

Remove_Replace HDRs

> Global Parameters Signaling Manipulation
Remaove_Unwanted_Headers

“| Global Profiles - - //The SBC will hardcode the PAI with the first DID number in the DID group,

//Which is also used for SIP Trunk Registration.

Domain DoS i //This is required in order to make outbound calls (IPO--3>PSTN) and for
Fingerprint ContuLink /fthe correct number to be displaved at the PSTN.
Server Interworking within session "INVITE®
CenturyLink_1 1
Phone Interworking act on request where %DIRECTION="QUTBOUND" and %ENTRY_POINT="POST_ROUTING"

Remove Remaote Address
Media Forking SHEADERS["P-Asserted-Identity"1[1].URI.USER = “5866948008";

Routing Add Supported_replaces ; }
Server Configuration

Topology Hiding JE—

signaling
Manipulaticn Add_100rel_1

URI Groups Replace 726 with 1786
> SIP Cluster
» Domain Policies
» TLS Management
> Device Specific Seftings
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6.2.5 Server Configuration

Server Profiles should be created for the Avaya SBCE’s two peers, the Call Server (IP Office) and
the Trunk Server or SIP Proxy at the service provider’s network.

To add the profile for the Call Server, from the Global Profiles menu on the left-hand navigation
pane, select Server Configuration. Click Add and enter the profile name: IP Office, click Next.

Add Server Configuration Profile

Profile Name IP Office

Next

On the Add Server Configuration Profile Tab:

Select Server Type: Call Server.

IP Address: 172.16.5.60 (IP Address of IP Office).
Supported Transports: Check UDP.

TCP Port: 5060.

Click Next.
Add Server Configuration Profile - General X
Semver Type Call Server E
172.16.5.68
IP Addresses / Supported FQDMNs
Separate entries with commas
[ TCcp
Supported Transports UDPI
s
TCP Port
UDP Port 5060 |
TLS Port
Back Next

Note: UDP is the recommended transport protocol to be used on the connection between the Avaya
SBCE and IP Office. However, TCP can be used instead if necessary.
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e Click Next on the Authentication tab (not shown).

e Click Next on the Heartbeat tab (not shown).

e On the Advanced tab, select Avaya-1PO from the Interworking Profile drop down menu.
Leave the Signaling Manipulation Script at the default None.

e Click Finish.

Add Server Configuration Profile - Advanced X

Enable DoS Protection [l

Enable Grooming B

Interworking Profile Avaya-IPO |Z||

Signaling Manipulation Script MNone E

UDP Connection Type @ SUBID © PORTID © MAPPING
[ Back | [ Finish ||

The following screen capture shows the General tab of the newly created IP Office Server
Configuration Profile.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: |P Office
Administration Add [m] m [m
Backup/Restore
Senver Profiles icati H b Ad q
System Management General | | | ‘ | ‘
> Global Parameters Session Manager Senver Type Call Server
Senice Prod

# [Glabal Profiles Snice Tromder IP Addresses | FQDNs 172.16.5.60

Domain DoS

Com Manager Supported Transports upp

Fingerprint —

Server Interworking UDP Port 5060

Phone Interworking IP Office

Edit

Media Forking Senice Provider -

Routing

Server Configuration

Topology Hiding

Signaling Manipulation

URI Groups
> SIP Cluster
> Domain Policies
> TLS Management
> Device Specific Settings
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The following screen capture shows the Advanced tab of the newly created IP Office Server
Configuration Profile.

Alarms  Incidents  Statistics Logs Diagnestics  Users Seftings Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Server Cenfiguration: [P Office
Administration Add Rename ][ Clone ][ Delete ]
Backup/Restore
Server Profiles Gi | icati Heartb
System Management | | | | | Advanced
Session Manager
» Global Parameters Enable DoS Protection ]
4 |Global Profiles Senice Provider
Enable Grooming =]

Domain DoS Com Manager

Fingerprint Interworking Profile Avaya- PO

5 9 p\t . C31000 s v

erver interworking Signaling Manipulation Script None
Phone Interwark [Poffice ]
one merworking UDP Connection Type SUBID

Media Forking Senice Provider -

Routing

Server Configuration

Topology Hiding

Signaling Manipulation

URI Groups
> SIP Cluster
> Domain Policies
> TLS Management
> Device Specific Settings

Similarly, to add the profile for the Trunk Server, from the Server Configuration screen, click Add
and enter the profile name: Service Provider, click Next.

Add Server Configuration Profile

|F'r0ﬁ|e Name Service Provider |
Next
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On the Add Server Configuration Profile Tab:
e Select Server Type: Trunk Server.
e IP Address: 142.125.72.11 (IP address for Service Provider’s SIP Proxy).
e Supported Transports: Check UDP.
e UDP Port: 5060.

e Click Next.
Add Server Configuration Profile - General X
Server Type Trunk Sarear =)
142.125.72.11
IF Addresses | Supported FODMNs
Separate entries with commas.
TCR
[E-uppcﬂaa Transports v ugpl
TLS
TCP Port
UDP Port 5060 |
TLS Port
Back Pect
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On the Authentication tab:

Check the Enable Authentication box.

Enter the User Name credential information supplied by the service provider for the
authentication of the SIP trunk.

Enter the Realm information supplied by the service provider for the authentication of the
SIP trunk. (Must be entered, currently cannot be detected automatically from the challenge).

Enter Password credential information supplied by the service provider for the
authentication of the SIP trunk.

e Click Next.
Add Server Configuration Profile - Authentication X
Enable Authentication i
User Name Useri23
Realm 2
(Leave Glank 10 detect from server chasenge) TS0
Password I
Confirm Passwaord TTI LI
—
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On the Heartbeat tab:
e Check the Enable Heartbeat box.
e Under Method, select REGISTER from the drop down menu.

e Frequency: Enter the amount of time (in seconds) between REGISTER messages that will
be sent from the enterprise to the Service Provider Proxy Server to refresh the registration
binding of the SIP trunk. This value should be chosen in consultation with the service
provider, 60 seconds was the value used during the compliance test.

e The From URI and To URI entries for the REGISTER messages are built using the

following:

- From URI: Use the User Name entered above in the Authentication screen (User123)
and the Service Provider’s domain name (pbx06dch2046.ca), as shown on the screen

below.

- To URI: Use the User Name entered above in the Authentication screen (User123) and
the Service Provider Proxy Provider’s domain name (pbx06dch2046.ca), as shown on
the screen below.

- Click Next.

Add Server Configuration Profile - Heartbeat X

Enable Hearibeat o
Method REGISTER =
Fraquency 80 seconds
From URI Usar1 23@pbx06dchI(:
Te URI 123@pbx06deh2046 ca
Back et
On the Advanced tab:

e Select SP-General from the Interworking Profile drop down menu.
e Under Signaling Manipulation Script, select the Hardcode PAI script created in Section

6.2.4.

e Click Finish.

Add Server Configuration Profile - Advanced X

Enable DoS Protection

Enable Greoming

Interworking Profile SP-Genaral =

Signaling Manipulation Script Hardcode PAl -

UDP Connection Type 2 3UBID PORTID MAPPING
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 56 of 94

SPOC 10/15/2014

©2014 Avaya Inc. All Rights Reserved. BellAIPO90ASBCE



The following screen capture shows the General tab of the newly created Service Provider Server

Configuration Profile.

Alarms  Incidents  Statistics Logs  Diagnostics  Users

Session Border Controller for Enterprise

System Management
> Global Parameters

4 |Global Profiles

Phone Interworking
Media Forking
Routing
Topology Hiding
Signaling Manipulation
URI Groups

» SIP Cluster

> Domain Policies

» TLS Management

> Device Specific Settings

Session Manager

Service Provider

Dashboard Server Configuration: Service Provider
Administration Add
Backup/Restore
Server Profiles General ” Authentication H Heartbeat H Advanced

Settings Help Log Out

AVAYA

Rename H Clone H Delete l

Server Type

IP Addresses / FQDNs

Trunk Server

142.125.72.11

Domain DoS
Com M
om Manager Supported Transports uppP
Fingerprint -
Server Interworking UDP Port 5060
IP Office

The following screen capture shows the Authentication tab of the newly created Service Provider

Server Configuration Profile.

Alarms  Incidents  Statistics Logs  Diagnostics  Users

Session Border Controller for Enterprise

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters

Phone Interworking
Media Forking
Routing
Topology Hiding
Signaling Manipulation
URI Groups

> SIP Cluster

> Domain Policies

> TLS Management

> Device Specific Settings

Server Configuration: Service Provider -

Add

Server Profiles

Session Manager

General H Authentication ” Heartbeat H Advanced

Settings Help Log Out

AVAYA

Rename ][ Clone ][ Delete ]

Enable Authentication

4 [Global Profiles
- User Name User123

Domain DoS Com Manager
Fingerprint Realm Realm
S | i CS1000

erver Interworking -

Edit
IP Office

HG; Reviewed:
SPOC 10/15/2014

Solution & Interoperability Test Lab Application Notes

©2014 Avaya Inc. All Rights Reserved.

57 of 94
BellAIPO90ASBCE



The following screen capture shows the Heartbeat tab of the newly created Service Provider
Server Configuration Profile.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: Service Provider -
Administrtion Add Rename ” Clone ” Delete ]
Backup/Restore
Ganerai| [ uthentaton) | ioarves: | Advanced
System Management
Session Manager
> Global Parameters Enable Heartbsat
4 [Global Profiles
Method REGISTER
Domain DoS Com Manager
Fingerprint Frequency 60 seconds
C51000

Server Interworking From URI User123@pbx06dch2046.ca

Phone Interwarking IP Office To URI User123@pbx06dch2046.ca

Media Forking

Routing

Server Configuration

Topology Hiding

Signaling Manipulation

URI Groups
> SIP Cluster

> Domain Policies
> TLS Management

> Device Specific Settings

The following screen capture shows the Advanced tab of the newly created Service Provider
Server Configuration Profile.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help  Log Out
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Backup/Restore

Systern Management G | || icati | Heartb ||Advanced I

Session Manager

> Global Parameters

4 [Global Profiles

Domain DoS

Enable DoS Protection (=]

Enable Grooming (=]
Com Manager

Fingerprint Interworking Profile SP-General
C51000
Server Interworking Signaling Manipulation Script Hardcode PAI

Phone Interworking IP Office
Media Forking

Routing
Server Configuration

Topology Hiding

UDP Connection Type SUBID

Signaling Manipulation
URI Groups

> SIP Cluster

> Domain Policies

> TLS Management

> Device Specific Settings
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6.2.6 Topology Hiding

Topology Hiding is a security feature which allows changing several parameters of the SIP packets,
preventing private enterprise network information from being propagated to the un-trusted public
network.

Topology Hiding can also be used as an interoperability tool to adapt the host portion in SIP headers
like To, From, Request-URI, Via, Record-Route and SDP to the IP addresses or domains expected
by Session Manager and the SIP trunk service provider, allowing the call to be accepted in each
case.

For the compliance test, only the minimum configuration required to achieve interoperability on the
SIP trunk was performed. Additional steps can be taken in this section to further mask the
information that is sent from the Enterprise to the public network.

To add the Topology Hiding Profile in the Enterprise direction, select Topology Hiding from the
Global Profiles menu on the left-hand side:

e Click on default profile and select Clone Profile (not shown).
e Enter the Profile Name: IP Office.

e Click Finish.
Clone Profile
Profile Name default
Clone Mame IP Office
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The following screen capture shows the newly created IP Office Topology Hiding Profile. Note that
no values were overwritten (default).

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Topology Hiding Profiles: IP Office

Administration

Add [ Rename H Clone H Delete ]
Backup/Restore

Jopoogyidng e
System Management 2P0 09y 'g ~rones Click here to add a description.

> Global Parameters e Topology Hiding
4 |Global Profiles| cisco_th_profile

Dornain DoS Session Manager Header Criteria Replace Action Overwrite Value
Fingerprint . i To IP/Domain Auto

Server Interworking endce_Provider Referred-By IP/Domain Auto -

Phone Interworking Com Manager Refer-To IP/Domain Auto

Media Forking €51000 Record-Route IP/Domain Auto =

Rouling Via IP/Damain Auta

Server Configuration

Topolegy Hiding SDP IP/Domain Auto —

Signaling Manipulation From IP/Domain Auto
URI Groups Request-Line IP/Domain Auto -
> SIP Cluster
. . Edit
> Domain Policies

> TLS Management
> Device Specific Settings

To add the Topology Hiding Profile in the Service Provider direction, select Topology Hiding from
the Global Profiles menu on the left-hand side:

e Click on default profile and select Clone Profile (not shown).
e Enter the Profile Name: Service_Provider.
e Click Finish.

Clone Profile X

Profile Mame default

|Clone Mame Service_Provider |
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Click Edit on the newly created Service_Provider Topology Hiding profile.

On the From choose Overwrite from the pull-down menu under Replace Action, enter the
domain name for the Service Provider (pbx06dch2046.ca) under Overwrite Value.

On the To choose Overwrite from the pull-down menu under Replace Action, enter the
domain name for the Service Provider (pbx06dch2046.ca) under Overwrite Value.

On the Request-Line choose Overwrite from the pull-down menu under Replace Action;
enter the domain name for the Service Provider (pbx06dch2046.ca) under Overwrite Value.
Click Finish.

Edit Topology Hiding Profile X

Header Criteria Replace Action Overwrite Value

| To |Z| IP/Domain |Z| Overwrite E| pbxl6dch2046.ca | Delete
Referred-By |E| IP/Domain |E| Auto E| Delete
Refer-To |E| IP/Domain |E| Auto E| Delete
Record-Route |z| IP/Domain |z| Auto E| Delete
Via |Z| IP/Domain |Z| Auto E| Delete
SDP |=| [IPDomain  [+| |Auto -] Delete
From |E| IP/Domain |E| Overwrite E| pbxl&dch2046.ca Delete
Request-Line |z| IP/Domain |z| Overwrite E| pbxl6dch2046.ca Delete
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The following screen capture shows the newly created Service_Provider Topology Hiding Profile.

Alarms  Incidents

Statistics

Logs Diagnostics

Users

Settings  Help

Log Out

Session Border Controller for Enterprise

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters

Topology Hiding Profiles: Service_Provider

Add

Topology Hiding Profiles Click here to add a description.

default

Topology Hiding

AVAYA

[ Rename ][ Clone ][ Delete ]

4 cisco_th_profile i .
Dornain DoS Header Criteria Replace Action Overwrite Value
) SeEILINEE To IP/Domain Overwiite pbx06dch2046 ca
Fingerprint _ _
Server Interworking Referred-By IP/Domain Auta -
Phone Interworking Com Manager Refer-To IP/Domain Auto —
Medlia Forking €51000 Record-Route IP/Domain Auta -
Routing IP Office Via IP/Domain Auto —
Server Configuration .
Topology Hiding SDP IP/Domain Auto —
Signaling Manipulation From IP/Domain Ovenwrite pbx06dch2046 ca
URI Groups Request-Line IP/Domain Overwrite pbx06dch2046.ca
» SIP Cluster
> Domain Policies
> TLS Management
» Device Specific Settings
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6.3 Domain Policies

Domain Policies allow the configuration of sets of rules designed to control and normalize the
behavior of call flows, based upon various criteria of communication sessions originating from or
terminating in the enterprise. Domain Policies include rules for Application, Media, Signaling,
Security, etc.

In the reference configuration, a new Application Rule and Signaling Rule were defined. All other
rules under Domain Policies, linked together on End Point Policy Groups, used one of the default
sets already pre-defined in the configuration. Please note that changes should not be made to any of
the defaults. If changes are needed, it is recommended to create a new rule by cloning one the
defaults and then make the necessary changes to the new rule.

6.3.1 Create Application Rules

Application Rules defines which types of SIP-based Unified Communications (UC) applications the
UC-Sec security device will protect: voice, video, and/or Instant Messaging (IM). In addition,
Application Rules defines the maximum number of concurrent voice and video sessions the network
will process in order to prevent resource exhaustion.

To add a new Application Rule, from the menu on the left-hand side, select Domain Policies >
Application Rules.

Select default trunk Rule (not shown).

Select Clone Rule button (not shown).

Enter the Application Rule Name: 500 Sessions.

e Click Finish.
Rule Name default
| Clone Name 500 Sessions| |
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e Click Edit on the newly created 500 Sessions Application Rule.

e Set the Maximum Concurrent Sessions and Maximum Sessions Per Endpoint per license
values specific to the enterprise, the value of 500 for Audio and 100 for Video was used in
the sample configuration.

e Click Finish.

Editing Rule: 500 Sessions X

S = Maximum rrent  Maximum
Application Type Qut g Per Ene
Audio 500 500
Video 100 100
M O O

Miscellaneous

@ Maone
CDR Support © CDRwf RTP
© CDR wfo RTP
RTCP Keep-Alive [

The following screen capture shows the newly created 500 Sessions Application Rule.

Alarms  Incidents  Statistics Logs Diagnestics  Users Seftings Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Application Rules: 500 Sessions

Administration

Add Filter By Device E [ Rename ” Clone ” Delete ]
Backup/Restore

DEn
System Management ppicauo Click here to add a description.
» Global Parameters TR Application Rule

> Global Profiles default-trunk

Application Type In  Out Maximum Concurrent Sessions  Maximum Sessions Per Endpoint
> SIP Cluster default-subscriber-low Aud 9 @ 50 500
4 |Domain Policies udie @ =
o default-subscriber-high
Application Rules Video 100 100
Border Rules default-server-low
i M o @
Media Rules default-server-high

Security Rules 2000 Sessions Miscellaneous

Signaling Rules

- CDR Support None
500 S
Time of Day Rules cssions

RTCP Keep-Alive No
End Point Policy

Groups

Session Policies

» TLS Management

» Device Specific Settings
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6.3.2 Signaling Rule

As mentioned in Section 2.2, Bell Aliant included a P-Asserted-Identity (PAI) header with an
“anonymous” parameter in the 200 OK messages sent from the network as a response to the INVITE
messages sent from the enterprise for outbound calls. This parameter made the display on the
enterprise extensions (calling party) change to “anonymous@avay unavaila” once the calls were
answered by the PSTN parties. To avoid this, a Signaling Rule was created to remove the PAI
header from the 200 OK messages arriving from Bell Aliant. This rule will later be applied to the
End Point Policy Group corresponding to the service provider.

To add the Signaling Rule, select Domain Policies - Signaling Rules, click Add (not shown).
e Enter an appropriate name, the name Remove PAI was chosen in this example.
e Click Next.

Signaling Rule

|Ru|e MName Remove PAI |

Mext

e Click Next on the next four tabs (not shown), leaving all fields in sections Inbound
Outbound, Content-Type Policies, QoS and UCDI with their default values.
e Click Finish (not shown).

On the newly created Remove PAI Signaling Rule, select the Response Headers tab to create the
manipulations performed on response messages. Select Add In Header Control.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out

Session Border Controller for Enterprise

AVAYA

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> SIP Cluster

.
Application Rules
Border Rules
Media Rules
Security Rules
Time of Day Rules

End Point Policy
Groups

Session Policies
> TLS Management
> Device Specific Settings

Signaling Rules: Remove PAI

Add Filter By Device. El [ Rename ” Clone ” Delete ]

Signaling Rules Click here to add a description.
I

defaul Headers HRespunse Headers || Signaling QoS ‘ ucip

Add In Header Cantrol ||| Add OutHeader Contral

Header Criteria  Action  Proprietary  Direction

MNo-Content-Type-Ch...

SessMgr_SigRule

Row Header Name Method Name

Response Code

Remote Workers

No response header controls exist.

Remave_headers

Remove PAI
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On the Add Header Control screen select the following:

Header Name: P-Asserted Identity.
Response Code: 2XX.

Method Name: INVITE.

Header Criteria: Forbidden.
Presence Action: Remove Header.
Click Finish.

Edit Header Control X

Proprietary Response Header

a

Header Name

Response Code

Method Name

P-Asserted-Identity

2XX| |

INVITE

[~

=

Header Criteria

Presence Action

@ Forbidden
) Mandatory
) optional

=

| Remove header

The following screen capture shows the Response Headers tab of the newly created Remove PAI

Signaling Rule.

Alarms  Incidents  Statistics

Users

Settings Help  Log Out

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> SIP Cluster

.
Application Rules
Border Rules
Media Rules
Security Rules
Time of Day Rules

End Point Policy
Groups

Session Policies
» TLS Management
» Device Specific Settings

Logs

Diagnostics

Signaling Rules: Remove PAI
Add

Session Border Controller for Enterprise

Filter By Device.. E

Signaling Rules Click here to add a description.

AVAYA

[ Rename ][ Clone ][ Delete ]

default

G .||r.

Hr‘

‘ | Request Headers || Response Headers || ‘ Si

ling Qos | [ uciD

No-Content-Type-Ch...
SessMgr_SigRule
Remaote Workers

Remave_headers 1

Remove PAI

P-Asserted-ldentity

Method
Name

Header Name Rsfpmss
Code

28X INVITE

Header
Criteria

Forbidden

[ Add In Header Control ] [ Add OutHeader Control I

Action

Proprietary Direction

Remove

Header o N

Edit Delete
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6.3.3 End Point Policy Groups

End Point Policy Groups are associations of different sets of rules (Media, Signaling, Security, etc.)
to be applied to specific SIP messages traversing through the Avaya SBCE.

To create an End Point Policy Group for the Enterprise, from the Domain Policies menu, select End
Point Policy Groups. Select Add (not shown).

e Group Name: Enterprise.

e Click Next.

Policy Group

Group Name Enterprise |

MNext

e Application Rule: 500 Sessions.
e Border Rule: default.

e Media Rule: default-low-med.
e Security Rule: default-low.

e Signaling Rule: default.

e Time of Day: default.

e Click Finish.
Policy Group X
Application Rule 500 Sessions E
Border Rule default E
Media Rule default-low-med El
Security Rule default-low E
Signaling Rule default E
Time of Day Rule def‘auItEl
][]
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The following screen capture shows the newly created Enterprise End Point Policy Group.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Policy Groups: Enterprise
Administration Add Filter By Device.. [~] [ Rename ][ Clone ][ Delete ]
Backup/Restore
System Management olicy Group: lick here to add a description
default-low
> Global Parameters Click here to add a row description.
> Global Profiles default-low-enc

Policy Group
> SIP Cluster e
4 |Domain Policies

Application Rules

Order Application Border Media Security Signaling Time of Day

Border Rules default-high B
1 500 Sessions default default-low-med  default-low default default Edit Clone

Media Rules default-high-enc
Security Rules OCS-default-high
Signaling Rules
Time of Day Rules avaya-def-low-enc
End Point Policy avaya-def-high-subs
Groups avaya-def-high-server
Session Policies

» TLS Management

» Device Specific Settings Senvice Provider
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Similarly, to create an End Point Policy Group for the Service Provider SIP Trunk, select Add.
e Group Name: Service Provider.
e Click Next.

Policy Group

Group Name

Service Provider

MNext

e Application Rule: 500 Sessions.
e Border Rule: default.
e Media Rule: default-low-med.

e Security Rule: default-low.

e Signaling Rule: Remove PAI (added in Section 6.3.2).
e Time of Day: default.
e Click Finish.

Policy Group X

Application Rule
Border Rule
Media Rule
Security Rule
Signaling Rule

Time of Day Rule

500 Sessions E
default [~]
default-low-med E
default-low El

Remove PA E

default[~]

[Back] [Fimisn |
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The following screen capture shows the newly created Service Provider End Point Policy Group.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help  Log Out
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Administration Add Filter By Device [~]

[ Rename ][ Clone ][ Delete ]
Backup/Restore

Policy Groups
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> Global Profiles default-low-enc

Policy Group
» SIP Cluster default-med
. 5 Add
default-med-enc

Application Rules

Order Application Border Media Security Signaling Time of Day

Border Rules kg
1 500 Sessions default default-low-med  default-low Remove PAI default Edit Clone

Media Rules default-high-enc
Security Rules OCS-default-high
Signaling Rules
Time of Day Rules avaya-deftlow-enc
End Point Policy avaya-def-high-subs__
Groups avaya-def-high-server
Session Policies

> TLS Management Brege

> Device Specific Settings
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6.4 Device Specific Settings

The Device Specific Settings allow the management of various device-specific parameters, which
determine how a particular device will function when deployed in the network. Specific server
parameters, like network and interface settings, as well as call flows, etc. are defined here.

6.4.1 Network Management

The network information should have been previously completed. To verify the network
configuration, from the Device Specific Settings menu on the left hand side, select Network
Management. Select the Network Configuration tab.

In the event that changes need to be made to the network configuration information, they could be
entered here.

For IP address assignments refer to Figure 1.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Network Management: Avaya SBCE
Administration
Backup/Restore
MHetwork Configuration | ‘ Interface Configuration
System Management
> Global Parameters Avaya SBCE
Modifications or deletions of an IP address or its associated data require an application restart before taking effect. Application restarts
> Global Profiles can be issued from System Management.
> SIP Cluster A1 Netmask A2 Netmask B1 Netmask B2 Netmask
> Domain Policies 2552552550 255.255.255.0
> TLS Management Add
“[Device Specific Settings IP Address Public IP Gateway Interface
Network
Management 17216571 172.16.5.254 Al E Delete
Media Interface 172.165.199 172.16.5.200 B1 [z] Delete
Signaling Interface
Signaling Forking
End Point Flows
Session Flows
Relay Services
SNMP
Syslog Management
Advanced Options
> Troubleshooting
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On the Interface Configuration tab, click the Toggle control for interfaces Al and B1 to change the
status to Enabled. It should be noted that the default state for all interfaces is disabled, so it is
important to perform this step, or the Avaya SBCE will not be able to communicate on any of its

interfaces.

Alarms  Incidents

Statistics

Users

Logs

Diagnostics

Seftings Help  Log Out

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters
> Global Profiles
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> Domain Policies

> TLS Management

S

Device Specific Settings

Network
Management

Media Interface
Signaling Interface
Signaling Forking
End Point Flows
Session Flows
Relay Services
SNMP

Syslog Management
Advanced Options

> Troubleshooting

Session Border Controller for Enterprise

Network Management: Avaya SBCE

Devices

MNetwork Configuration || Interface Configuration |

AVAYA

Avaya SBCE Administrative Status

Name

Al Enabled

Toggle

A2 Disabled

Toggle

EE Enabled

Toggle |

B2 Disabled

Toggle
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6.4.2 Media Interface

Media Interfaces were created to adjust the port range assigned to media streams leaving the
interfaces of the Avaya SBCE. On the Private and Public interfaces of the Avaya SBCE ports range
35000 to 40000 was used.

From the Device Specific Settings menu on the left-hand side, select Media Interface. Below is the
configuration of the inside, private Media Interface of the Avaya SBCE.

e Select Add in the Media Interface area (not shown).

e Name: Private_med.

e IP Address: 172.16.5.71 (Inside or A1 IP Address of the Avaya SBCE, toward IP Office).
e Port Range: 35000-40000.

e Click Finish.
Name Private_med|
IP Address 172.16.5.71 F
Port Range 35000 - 40000
Finish
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Below is the configuration of the outside, public Media Interface of the Avaya SBCE.
e Select Add in the Media Interface area.
e Name: Public_med.
e IP Address: 172.16.5.199 (Outside or B1 IP Address of the Avaya SBCE, toward the
Service Provider).
e Port Range: 35000-40000.
e Click Finish.

The following screen capture shows the newly created Media Interfaces.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Media Interface: Avaya SBCE

Administration
Backup/Restore

System Management

> Global P t Avaya SBCE

obal Farameters Modifying or deleting an existing media interface will require an application restart before taking effect. Application restarts can be issued
» Global Profiles from System Management.
» SIP Cluster oA

> Domain Policies
Name Media IP Port Range
» TLS Management - 4

4+ [Device Specific Settings Private_med 172.16.5.71 35000 - 40000 Edit Delete

Network Management Public_med 17216 5199 35000 - 40000 Edit Delste

Media Interface

Signaling Interface

Signaling Forking
End Point Flows
Session Flows
Relay Services
SNMP

Syslog Management
Advanced Options

> Troubleshooting
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6.4.3 Signaling Interface
To create the Signaling Interface toward IP Office, from the Device Specific menu on the left hand
side, select Signaling Interface (not shown).

e Select Add in the Signaling Interface area (not shown).

e Name: Private_sig.

e Select IP Address: 172.16.5.71 (Inside or Al IP Address of the Avaya SBCE, toward IP

Office).
e UDP Port: 5060.
e Click Finish.
Add Signaling Interface X
MName Private_sig
IP Address 17216571 E
TCP Port
Leave blank to disable
UDP Port
Leave b|gl1'( to disable 5060
Enable Stun [
TLS Port
Leave blank to disable
TLS Profile AvayaSBCServer
Enable Shared Control
Shared Control Port
=
HG; Reviewed: Solution & Interoperability Test Lab Application Notes 75 of 94

SPOC 10/15/2014 ©2014 Avaya Inc. All Rights Reserved. BellAIPO90ASBCE



Below is the configuration of the outside, public signaling Interface of the Avaya SBCE.
e Select Add in the Signaling Interface area (not shown).
e Name: Public_sig.
e IP Address: 172.16.5.199 (Outside or B1 IP Address of the Avaya SBCE, toward the
Service Provider).
e UDP Port: 5060.
e Click Finish.

Add 5Signaling Interface X

MName Public_sig
IP Address 1?2.15.5.199E
TCP Port
Leave blank to disable
ﬂEi 't::lg gk to disable 5060
Enable Stun [
TLS Port

Leave blank to disable
TLS Profile AvayaSBCServer
Enable Shared Control

Shared Control Port

The following screen capture shows the newly Created Signaling Interfaces.
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pecupesore [ oees [IETS—
D s Si il Interf;
System Management evices ignaling Interface

Avaya SBCE

> Global Parameters Add

> Global Profiles Signaling IP TCP Port UDP Pot TLS Port LS Prafile
> SIP Cluster

> Domain Policies

Private_sig 172.16.5.711 5060 MNone Edit Delete

Public_sig 172.16.5.199 - 5060 - MNone Edit Delete
> TLS Management

4 |Device Specific Settings

Network Management

Media Interface
Signaling Forking
End Point Flows
Session Flows
Relay Services
SNMP

Syslog Management
Advanced Options

> Troubleshooting
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6.4.4 End Point Flows

When a packet is received by UC-Sec, the content of the packet (IP addresses, URIs, etc.) is used to
determine which flow it matches. Once the flow is determined, the flow points to a policy which
contains several rules concerning processing, privileges, authentication, routing, etc. Once routing is
applied and the destination endpoint is determined, the policies for this destination endpoint are
applied. The context is maintained, so as to be applied to future packets in the same flow. The
following screen illustrates the flow through the Avaya SBCE to secure a SIP Trunk call.

‘Call Server —
D D Policy Graup oy
‘Call Server” —_— ¥ Trunk'Policy
<] Paicy Group G Aw Croup <] G

The End-Point Flows defines certain parameters that pertain to the signaling and media portions of
a call, whether it originates from within the enterprise or outside of the enterprise.

1P-PRX

S Trunk Service Prowder
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To create the call flow toward the Service Provider SIP trunk, from the Device Specific Settings

menu, select End Point Flows, tab Server Flows. Click Add Flow (not shown).

HG; Reviewed:
SPOC 10/15/2014

Name: SIP_Trunk_Flow.

Server Configuration: Service Provider.

URI Group: *
Transport: *
Remote Subnet: *

Received Interface: Private_sig.
Signaling Interface: Public_sig.
Media Interface: Public_med.

End Point Policy Group: Service Provider.
Routing Profile: Route_to_IPO (Note that this is the reverse route of the flow).
Topology Hiding Profile: Service_Provider.

File Transfer Profile: None.

Click Finish.

Add Flow X

Flow Mame

Server Configuration
URI Group

Transport

Remote Subnet
Received Interface
Signaling Interface
Media Interface

End Point Policy Group
Routing Profile
Topology Hiding Profile

File Transfer Profile

SIP_Trunk_Flow
Service Provider E
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Private_sig E
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Public_med [~]
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Route_to_IPO E

Service_Provider E

NoneE
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=3
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To create the call flow toward the IP Office, click Add Flow.
e Name: IP_Office Flow.

e Server Configuration: IP Office.

e URI Group: *
e Transport: *

e Remote Subnet: *

e Received Interface: Public_sig.

e Signaling Interface: Private_sig.

e Media Interface: Private_med.

e End Point Policy Group: Enterprise.
e Routing Profile: Route_to_SP (Note that this is the reverse route of the flow).
e Topology Hiding Profile: IP Office.
e File Transfer Profile: None.

e Click Finish.

Add Flow X

Flow Name

Server Configuration
URI Group

Transport

Remote Subnet
Received Interface
Signaling Interface
Media Interface

End Point Policy Group
Routing Profile
Topology Hiding Profile

File Transfer Profile

IP_Office_Flow
IP Office

: [=]
* =]
Public_sig [=]
Private_sig E
Private_med E
Enterprise
Route_to_SP

IP Office

None |Z|

[=]

[=]
[=]

HG; Reviewed:
SPOC 10/15/2014

Solution & Interoperability Test Lab Application Notes
©2014 Avaya Inc. All Rights Reserved.

79 of 94
BellAIPO90ASBCE



The following screen capture shows the newly created Server Flows.
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End Point Flows: Avaya SBCE

Subscriber Flows ‘ | Server Flows

Settings Help  Log Out

AVAYA

Avaya SBCE

Click here to add a row description.

Add

Server Config ion: IP Office

URI Received
Interface

End Point
Policy Group

Signaling

Flow Name Interface

Priority

Group

1 IP_Office_Flow ® Public_sig Private_sig Enterprise

Routing
Profile
Route_ta_SP View

Clone Edit Delete

Server Configuration: Service Provider

Signaling Forking oy Aol Gl:w:ijp o s FEI?dyFl;rmLp eI

1 SIP_Trunk_Flow  ~* Private_sig Public_sig g?xgzr Route_to_IPO  View Clone Edit Delete

Session Flows

Relay Services

SNMP

Syslog Management

Advanced Options

» Troubleshooting
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7. Bell Aliant SIP Trunk Service Configuration

To use Bell Aliant’s SIP Trunk service, a customer must request the service from Bell Aliant using
the established sales processes. The process can be started by contacting Bell Aliant via the
corporate web site at: http://www.bellaliant.ca/index.shtml and requesting information.

During the signup process, Bell Aliant and the customer will discuss details about the preferred
method to be used to connect the customer’s enterprise network to Bell Aliant’s network. In the
configuration described under these Application Notes, an IPSec VPN Tunnel was used. Bell Aliant
will provide IP addresses, Direct Inward Dialed (DID) numbers to be assigned to the enterprise, etc.
This information is used to complete the Avaya IP Office and Avaya Session Border Controller for
Enterprise configuration discussed in the previous sections.

During the interoperability testing, a VPN connection was used to connect the simulated enterprise
site to Bell Aliant’s network via the public Internet. The connection could also be done without the
use of VPN, by directly connecting the Avaya SBCE to a public facing SBC located in Bell Aliant’s
network. This is accomplished by assigning public IP addresses capable of being reached across the
public Internet, to the Avaya SBCE (interface B1) and to the Bell Aliant’s SBC.
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8. Verification and Troubleshooting

This section provides verification steps that may be performed in the field to verify that the solution
is configured properly. This section also provides a list of useful troubleshooting tips that can be
used to troubleshoot the solution.

8.1 Verification Steps

The following steps may be used to verify the configuration:

e Verify that endpoints at the enterprise site can place calls to PSTN and that calls remain
active for more than 35 seconds. This time period is included to verify that proper routing of
the SIP messaging has satisfied SIP protocol timers.

o Verify that endpoints at the enterprise site can receive calls from PSTN and that calls can
remain active for more than 35 seconds.

e Verify that the user on the PSTN side can end an active call by hanging up.

e Verify that an Avaya endpoint at the enterprise site can end an active call by hanging up.

8.2 Protocol Traces

The following SIP message headers are inspected using sniffer trace analysis tool:
Request-URI: Verify the request number and SIP domain.

From: Verify the display name and display number.

To: Verify the display name and display number.

P-Asserted-Identity: Verify the display name and display number.
Privacy: Verify privacy masking with “user, id”.

Diversion: Verify the display name and display number.

The following attributes in SIP message body are inspected using sniffer trace analysis tool:
Connection Information (c line): Verify IP addresses of near end and far end endpoints.
Time Description (t line): Verify session timeout value of near end and far end endpoints.
Media Description (m line): Verify audio port, codec, DTMF event description.

Media Attribute (a line): Verify specific audio port, codec, ptime, send/ receive ability,
DTMF event and fax attributes.
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8.3 IP Office System Status

The following steps can also be used to verify the configuration.

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start = Programs = IP Office = System Status on the PC
where IP Office Manager is installed. Select the SIP Line of interest from the left pane. On
the Status tab in the right pane, verify that the Current State is Idle for each channel
(assuming no active calls at present time).

IP Office System Status

Status | Utization Summary Alarms.

SIP Trunk Summary

Peer Domain Name: sip://172.16.5.71

Resolved Address: 172.16.5.71

Line Number: 17

Number of Administered Channels: 10

Number of Channels in Use: 0

Administered Compression: G711 Mu, G711 A, G725 A
Silence Suppression: off

Layer 4 Protocol: UDP

SIP Trunk Channel Licenses: Unlimited . -
SIP Trunk Channel Licenses in Use: 0

SIP Device Features: REFER (Incoming and Outgoing)

a Codec Comnecon CallerDor OtherPartyonCal  Directionof RoundTrip  Receive Jitt Transmit  Transmit
Type Dialed Digits call Delay . Jitter PacketLos...

1 Idle 00:24:17
2 Idle 00:24:29
3 Idle 06:45:40
4 Idie 06:45:40
5 Ide 06:45:40
& Idle 06:45:40
7 Ide 06:45:40
8 Idie 06:45:40
9 Ide 06:45:40
10 Ide 06:45:40

e Select the Alarms tab and verify that no alarms are active on the SIP Line.

IP Office System Status

Status  Utiization Summary Alarms

Alarms for Line: 17 SIP sip://172.16.5.71

Last Date Of Error Error Description

Clear Clear Al Print...
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8.4 IP Office Monitor

The Avaya IP Office Monitor application can be used to monitor and troubleshoot signaling
messaging on the SIP trunk. Launch the application from Start = Programs = IP Office -
Monitor on the PC where Avaya IP Office Manager was installed. Click the Select Unit icon on the
taskbar and Select the IP address of the IP Office system under verification.

Iﬂ_ Avaya IP Office SysMonitor - [STOPPED]
File Edit “iew Filkers Status Help

=8| »8T| x|V @ ==

' F4 4

Start/Stop Trace Select
Trace Options  Unit

Clicking the Trace Options icon on the taskbar and selecting the SIP tab allows modifying the
threshold used for capturing events, types of packets to be captured, filters, etc. Additionally, the
color used to represent the packets in the trace can be customized by right clicking on the type of
packet and selecting to the desired color.

All Settings [
T1 | wComp | wPM | weN | son | ssl | vade |
aTM | Cal | DTE | EConf | FrameRelay | GOD | H.323 | Interface |
ISCM | F.ew/Lamp | Director | Media | FPFF | R2 | Routing | Services  SIP |S_I.Jstem|
Ewventz
W Sip  |verhoze = [ STUN [~ SIP Dect
Packets
[~ SIP Reg/Opt Rx [~ SIP Mizc Rx
[~ SIPReg/Opt Tx [~ SIP Mizc Tx
[ SIPCall A= [~ Crn Motify Rix
[~ SIPCall Tw [~ Crn Motify T
v Sip Rx [ hex |P Filter [nnn.nnn.nnn.nnn)
¥ Sip Tx ™ hex |
Default .a.u‘ Clear All | Tab Clear.t'-\ll‘ Tab SetAII‘ T~
B ‘ e | Load Partial File‘ &l Flz |
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The screen capture below shows an Invite and a 100 Trying response messages generated by an
incoming call from the PSTN to IP Office.

15:50:57 268963836mS SIP Rx: UDP 172.16.5.71:5060 -»> 172.16.5.60:5060
INVITE 2ip:5066948000;phone-context=national@172.16.5.6
From: <3ip:786331 :phone-ceontext=naticnal@172.16.5.7
T

;user=phone SIE/2.0

5060; user=phone>; tag=52105
<31p:5066948000;phone-context=national@172.16.5. 60;user=phone>

q: 35879 INVITE I
1-ID: 7Th240240££5d87260637990adba3bl20

Contact: <3ip:78633 ;phone-context=national@172.16.5.71:5060; transport=udp>

Record-Route: <sip: 16.5.71:5060;ipca-1ine=107;1r; transport=udp>

Rllow: INVITE,BYE,CENCEL, ACK, REGISTER, SUBSCRIBE, NOTIFY, UPDATE, MESSAGE, INFO, REFER, OPTIONS, FUBLISH, ERACK

Supported: com.nortelnetworks.firewall,p-3rdpartycontrol,nosec,join,x-nortel-sipvc,gin, com.nortelnetworks.im.encryption, replaces, tdialog, 100rel

User-Agent: Nortel SESM 17.0.12.16

Max-Forwards: 18

Via: SIP/2.0/UDP 172.16.5.71:5060;branch=z9hG4bK-91632-001758027414-1--31632-

Content-Type: application/sdp

E-nt-corr-id: a6ad7lea-2zal-1b21-Ebéa-000=0chibess

x-nt-location: -1

Content-Length: 208

m

v=0
o=IWSPM 605284667 605284667 IN IF4 172.16.5.71
-

c=IN IP4 172.16.5.71

t=0 0

meaudic 35010 RTE/AVE 0 8 18 101

a=ptime:20

a=fmtp:18 annexb=no

a=rtpmap:101 telephone-event/&000

a=fmrp:101 0-15

5mS STR Tx: -> 172.16.5.7

14-1--31632-
ip>

r=phone>;tag=52105

< .
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8.5 Avaya Session Border Controller for Enterprise

There are several links and menus located on the taskbar at the top of the screen of the web interface
that can provide useful diagnostic or troubleshooting information.

Alarms: Provides information about the health of the Avaya SBCE.

Alarms  Incidents  Statistics

Dashboard
Administration
Backup/Restore

> Global Profiles

> SIP Cluster

> Domain Policies

» TLS Management

» Device Specific Settings

Logs

Session Border Controller for Enterprise

Dashboard

Information

System Time 11:08:59 AM GMT Refresh EMS
System Management
Vi 6.2.1.Q16
> Global Parameters erston REPEECE
Build Date Wed May 28 09:21:02 UTC 2014

None found.

Diagnostics

Help

AVAYA

Log Out

Users Settings

Installed Devices

Incidents (past 24 hours)

Alarms (past 24 hours)
Avaya SBCE: No Server Flow Matched for Incoming Message

Avaya SBCE: No Server Flow Matched for Incoming Message
Avaya SBCE: No Server Flow Matched for Incoming Message
Avaya SBCE: No Server Flow Matched for Incoming Message

Avaya SBCE: No Server Flow Matched for Incoming Message

Add

No notes found.

The following screen shows the Alarm Viewer page.

Devices

EMS

Avaya SBCE

Alarm Viewer

Alarms

AVAYA

No alarms found for this device.

Details

Clear Selected | [ Clear Al
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Incidents : Provides detailed reports of anomalies, errors, policies violations, etc.

Alarms  Incidents  Stati

Diagno:

Logs

Settings Help  Log Out

Dashbeard
Administration
Backup/Restore

System Management

> Global Parameters

> Global Profiles

> SIP Cluster

> Domain Policies

» TLS Management

» Device Specific Settings

Session Border Controller for Enterprise

Dashboard
System Time 11:08:59 AM GMT Refresh
Version 6.2.1.Q16
Build Date Wed May 26 09:21:02 UTC 2014
None found.

AVAYA

Installed Devices

EMS

Avaya SBCE

Incidents (past 24 hours)

Avaya SBCE: No Server Flow Matched for Incoming Message
Avaya SBCE: No Server Flow Matched for Incoming Message
Avaya SBCE: No Server Flow Matched for Incoming Message
Avaya SBCE: No Server Flow Matched for Incoming Message

Avaya SBCE: No Server Flow Matched for Incoming Message

Add

No notes found.

The following screen shows the Incident Viewer page.

Incident Viewer AVAYA

Device | Al [+] category|Al Refresh | | Generate Report |

|Z| Clear Filtars

Displaying results 1to 15 out of 985.

Category

Message Dropped 704480943973450 8/25/14 10:18 AM Policy Avaya SBCE Mo Server Flow Matched for Incoming Message
Message Dropped 704480879990938 8/25/14 10:15 AM Paolicy Avaya SBCE Mo Server Flow Matched for Incoming Message
Message Dropped 704480822092305 8/25/14 10:14 AM Paolicy Avaya SBCE Mo Server Flow Matched for Incoming Message

Cause
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Diagnostics: This screen provides a variety of tools to test and troubleshoot the Avaya SBCE
network connectivity.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help  Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Dashboard

Administation nstalled Devices

Backup/Restore System Time 11.08:59 AM GMT Refiesh  EMS

System Management

> Global Parameters Version il Avaya SBCE

> Global Profiles Build Date Wed May 28 09-21:02 UTC 2014

» SIP Cluster

. Domain Policies Alarms (past 24 hours) Incidents (past 24 hours)

> TLS Management None found. Avaya SBCE: No Server Flow Matched for Incoming Message

» Device Specific Settings Avaya SBCE: No Server Flow Matched for Incoming Message

Avaya SBCE: No Server Flow Matched for Incoming Message
Avaya SBCE: No Server Flow Matched for Incoming Message

Avaya SBCE: No Server Flow Matched for Incoming Message

Add

Mo notes found.

The following screen shows the Diagnostics page.

Diagnostics AVAYA

Full Diagnostic ‘ ‘ Ping Test | | Application | | Protocol |
Avaya SBCE

Task Description Status

- eths is operating within normal parameters with a full duplex connection
EMS Link Check at 100Mbrs.

- . eth3 is operating within normal parameters with a full duplex connection
SBC Link Check: A1 at 100Mb/s.

- . eth1 is operating within normal parameters with a full duplex connection
SBC Link Check: B1 at 100Mb/s.

Ping: SBC (172.16.5.71) to
Ping: Gateway (172.16.6.264) Average ping from 172.16.5.71 to 172.16.5.254 is 2.376ms.
Ping: SBC (172.16.5.71) to

Ping: Primary DNS (172.16.5.102) Error: Unable to reach 172.16.5.102 from 172.16.5.71.

Ping: SBC (172.16.5.199) to : :
Ping Gateway (172.16.5.200) Awverage ping from 172.16.5.199 to 172.16.5.200 is 1.717ms.

Ping: SBC (172.16.5.199) ta
Ping: Primary DNS (172.16.5.102)

Q 3 0 O @ & 9

Error: Unable to reach 172.16.5.102 from 172.16.5.199.
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Additionally, the Avaya SBCE contains an internal packet capture tool that allows the capture of
packets on any of its interfaces, saving them as pcap files. Navigate to Device Specific Settings >
Troubleshooting = Trace. Select the Packet Capture tab, set the desired configuration for the
trace and click Start Capture.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out

Session Border Controller for Enterprise

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> SIP Cluster

> Domain Policies

> TLS Management

« [Gevies Specie Seings|
Network Management
Media Interface
Signaling Interface
Signaling Forking
End Point Flows
Session Flows
Relay Services
SNMP
Syslog Management
Advanced Options
< Troubleshooting

Debugging

DoS Learning

Trace: Avaya SBCE

Devices

Avaya SBCE

Call Trace | | Packet Capture || Captures ‘

AVAYA

Packet Capture Configuration

Status Ready

Interface Any|z|
Local Address o
e Alllx]:

Remote Address
=, *Part, IP, IF:Port

Protocol All E

Maximum Number of Packets to Capture 10000

Capture Filename |
=

Using the name of an existing capture will overwrite it
Start Caplure Clear
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Once the capture is stopped, click the Captures tab and select the proper pcap file. Note that the
date and time is appended to the filename specified previously. The file can now be saved to the
local PC, where it can be opened with an application such as Wireshark.

Alarms  Incidents  Statistics  Logs  Diagnostics  Users Settings Help  Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Trace: Avaya SBCE
Administration

Backup/Restore

System Management Call Trace | ‘ Packet Capture ‘ | Capluresl
> Global Parameters Avaya SBCE Last Madified [~ | | Descending[~]

> Global Profiles
> SIP Cluster
> Domain Policies

File Name File Size (bytes) Last Modified
Mo_180_20140721045220_pcap 622,592 July 21, 2014 4:52:38 AM GMT Delete

Xfer_Good_Audio_20140702045247 pcap 1,949,696 July 2, 2014 4:53:48 AM GMT Delete
> TLS Management

4 |Device Specific Settings

Netwoark Management
Media Interface

Signaling Interface

Signaling Forking

End Point Flows

Session Flows

Relay Services

SNMP

Syslog Management

Advanced Options

4 Troubleshooting
Debugging

DoS Learning
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9. Conclusion

These Application Notes describe the procedures required to configure SIP trunk connectivity
between Avaya IP Office 9.0, Avaya Session Border Controller for Enterprise R6.2 and Bell Aliant
SIP Trunking Service, as shown in Figure 1.

Interoperability testing was completed successfully with the observations/limitations noted in
Section 2.2
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11. Appendix A: SigMa Script

The following is the Signaling Manipulation script used in the configuration of the Avaya SBCE,
Section 6.2.4:

Title: Hardcode PAI

/IThe SBC will hardcode the PAI with the first DID number in the DID group,
//Which is also used for SIP Trunk Registration.

/[This is required in order to make outbound calls (IPO-->PSTN) and for

/lthe correct number to be displayed at the PSTN.

within session "INVITE"
{

act on request where %DIRECTION="OUTBOUND" and
%ENTRY_POINT="POST_ROUTING"

{

¥
k

%HEADERS["P-Asserted-ldentity"][1].URI.USER = "5066948000";
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Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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